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Installing Harmony Server

At the heart of the Harmony solution is the server, which centralizes all the production assets in a repository.
Loaded with production proven tools to manage administration tasks, the server is completely flexible and will fit
in your existing infrastructure, whether you are onWindows, Mac or Linux.

In addition, the server is critical at the end of a production for rendering projects efficiently. The Rendering
process, controlled directly by the server, not only renders production scenes but also executes the batch
vectorization of the scanned drawings. You can send an unlimited number of scenes to render and change their
priorities depending on your deadline! You can also render final frames locally or batch process over a network in
the background or at scheduled times.

You can install Harmony Server onWindows, MacOS X and Linux.

If you plan to also use a render farm or batch vectorize scanned drawings, you will also need to set up the batch
processing tasks.

IMPORTANT: Make sure to shut down all the services on the web server when you upgrade the version. If you don't,
it will not replace the startup scripts because they are busy and locked. Make sure to do this before installation.

This guide is divided as follows:

• Installing onWindows on page 11

• Configuring HarmonyWeb Control Center onWindows on page 43

• Installing onMacOS X on page 57

• Configuring HarmonyWeb Control Center onMacOS X on page 89

• Installing on Linux on page 99

• Configuring HarmonyWeb Control Center on Linux on page 131

• Batch Processing on page 137

If you will also use an industrial scanner and the Scanmodule to batch scan and vectorize drawings, refer to the
ScanGuide to learn how to install and set up the scanner.

To learnmore about Harmony and its main components, refer to the Fundamentals Guide.
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Chapter 1: Installing on Windows
This document explains how to install Toon BoomHarmony onWindows.

There are three stages required to install Toon BoomHarmony 12.1, which are covered in the following topics:

1. Pre-installation on page 11

2. Installing Toon BoomHarmony on page 16

3. Configuration on page 21

After completing these stages, you can verify the integrity of the installation and resolve any configuration issues.

• Troubleshooting on page 41

Pre-installation
Before installing Toon BoomHarmony, youmust perform the following tasks:

• Verifying theMinimumRequirements on page 11

• Prerequisites for Harmony Installation on page 11

• Pre-installation Configuration on page 13

Verifying the Minimum Requirements

For theminimum hardware requirements, visit: System Requirements.

For themost current Toon BoomHarmony hardware requirements, refer to theHarmony and Your IT
Department white paper available from:

• Toon BoomAnimation Sales Representative

• Toon BoomAnimation Support at: support@toonboom.com.

Prerequisites for Harmony Installation

For a fast database connection, it is necessary to set up extra network settings so clients can perform a fast
Name Resolution of the server, as well as the server to the clients.

• Obtaining the Product Code on page 11

• Additional Network Settings on page 12

• Windows 2008 Server on page 12

Obtaining the Product Code

You should obtain a product code from the Toon Boom licensor, so you can finish the installation process without
having to wait for the activation code to arrive.

To obtain a Harmony 12.1 product code, send the following information to: licensor@toonboom.com.

• Your name and the name of your company

• Email address where to send the license file
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Additional Network Settings

NOTE: You should edit the hosts file only if there are problems or slowness when a computer is resolving names.
DO NOT edit the hosts file unless there are problems resolving names on the network.

How to edit the hosts file

1. Set up the server and clients' IP with a static (fixed) IP address.

2. Go to C:\WINDOWS\system32\drivers\etc\ folder and open the hosts file using a plain text editor.

3. Go to the end of the file, on a new line add the static IP address and themachine name accordingly. If
you are using a domain, you need to use the fully qualified domain name (FQDN).

For example, if the server name is server.toonboom.com in the domain and the IP address of the
server is 192.168.1.1, the line should be:

192.168.1.1 server.toonboom.com

4. Add the rest of the client's IP and hostname on a new line and click Save.

5. Copy and paste the hosts file to all themachines including the server under the C:\WINDOWS\sys-
tem32\drivers\etc\ folder.

Windows 2008 Server

For a Windows 2008 server, you need to perform some additional steps to complete the task.

If you have a domain, you need to add a usabatch user on the global group where all the Harmony users are.
This user should have administrator account rights.

• The user name is usabatch

• The password is usabatch

If an error due to the password policy occurs, you can change the password policies for both the Domain
Controller Security Policy and Domain Security Policy. You also need to do this from the Domain server if it is
different from the Harmony database server.

1. From theWindows Start menu, select Control Panel.

2. In Control Panel, double-click onAdministrative Tools.

3. In Administrative Tools, select Group Policy Management.

4. In the hierarchy view of theGroup Policy Management, go into the Domain used by Harmony, right-
click onDefault Domain Policy and select Edit.

5. In the hierarchy view of theGroup Policy Management Editorwindow, go inComputer Configuration
> Policies >Windows Settings > Security Settings > Account Policies > Password Policy.

6. On the right side of theGroup Policy Management Editorwindow, double-click on Passwordmust
meet complexity requirements.

12



Harmony 12.1 Server Installation Guide

7. Select theDefine this policy setting andDisabled options.

8. Click OK.

Wait for the changes to take effect or restart the Server. It can take several minutes for the domain
controller to update and use the new settings.

Once this is done, you can create the usabatch user, which should be inside the Harmony user group.

Pre-installation Configuration

Before installation, configure your computer by performing the following tasks:

• Turning off Anti-Virus Software on page 13

• Turning Off the Firewall on page 14

• Turning Off Use Simple File Sharing on page 15

NOTE: Inform your System Administrator before proceeding with these tasks.

Turning off Anti-Virus Software

NOTE: Inform your System Administrator before proceeding with this task.

How to turn off your anti-virus software

1. From the Start menu, select Settings > Control Panel.

Vista Users: Click the Startmenu and select Control Panel.

The Control Panel opens.

2. In the Control Panel window, double-click on the Security Center icon .

Vista Users: Turn offMalware Protection.

TheWindows Security Center dialog box opens.
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3. If your anti-virus software is not detected, open all anti-virus software applications on your computer
and disable each onemanually.

Turning Off the Firewall

NOTE: Inform your System Administrator before proceeding with this task.

How to turn off the Windows firewall

1. From the Start menu, select Control Panel.

2. Double-click on theWindows Firewall icon.

3. In theWindows Firewall window, click Turn Windows Firewall On or Off on the left side of the window.

The Customize Settings for Each Type of Network dialog box displays.
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4. Select the Turn off Windows Firewall option for both private and public network locations.

5. Click OK.

Turning Off Use Simple File Sharing

How to turn off simple file sharing

1. From the Start menu, select Computer.

2. From theOrganize menu, select Folder and Search Options.

The Folder Options dialog box opens.

3. In the View tab, deselect theUse SharingWizard (Recommended) option.
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Installing Toon Boom Harmony
Now that you have verified theminimum requirements and configured your hardware and software, you are
ready to install Toon BoomHarmony.

You will perform the following tasks:

1. Upgrading from a Previous Installation on page 16

2. Installing Toon BoomHarmony on page 20

Upgrading from a Previous Installation

If you are not upgrading from a previous installation of Toon BoomHarmony, go to Installing Toon Boom
Harmony on page 20.

If you are performing an upgrade, pick a timewhen Toon BoomHarmony production is slow or stopped.
During the upgrade, no users can run any of the Toon BoomHarmonymodules and all rendering jobs must be
stopped or completed.

Before you can update a previous installation of Toon BoomHarmony, youmust stop all services, including:

• The database server

• Batch processing

• The license server

Stopping Services Affecting Harmony

How to stop all services affecting Toon Boom Harmony

1. Make sure that no one is running Toon BoomHarmony. All instances of Harmonymust be closed on the
server and on all the clients.
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2. Make sure that all batch rendering or vectorizing is complete or that the queues are empty. In the Control
Center module, use theQueuemenu to open the Vectorize and Render Queue for all environments. The
queues should be empty or the status of all jobs should be "Completed".

Upgrading from versions 7.8, 9.2 or a previous version of 10:

‣ From the Start menu, select All Programs > Toon Boom Harmony > Tools > Control Panel.

The Harmony Control Panel dialog box opens.

Upgrading from a previous version of 7.3:

‣ From the Start menu, select All Programs > Toon Boom Animation > Toon Boom Harmony > Tools
> Harmony Control Panel.

The Harmony Properties window opens.

Upgrading from version 7.2 or earlier:

‣ From the Start menu, select All Programs > Toon Boom Harmony (or Opus) > Configuration Tools >
usa_cfg.

The USAnimation Properties window opens.

3. From the Process Start menu, select Stop. Do this for every Toon BoomHarmony-related process running
on themachine.

You can also stop tbdbserver on the server and tbprocess onworkstations that are set as a batch
render.

4. Turn off all the client machines and the render farm.

Stopping the License Server

How to stop the license server

1. On the License server computer, from the Start menu, select All Programs > Harmony > Configuration
Tools > FLEXlm - lmtools.

The LMTOOLSwindow opens.

Upgrading from version 7.3: Click the Start menu and select All Programs > Toon Boom Animation >
Harmony > Tools > Flexlm Tools.
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Upgrading from version 7.8: Click the Start menu and select All Programs > Toon Boom Harmony
7.8 > License Tools > Flexlm Tools.

2. In the Start/Stop/Reread tab, select the license server from the FLEXnet license services installed on
this computer list.

3. Click Stop Server.

4. In the Config Services tab, click Remove Service to remove the license service.

5. Close the LMTOOLSwindow.

Removing Harmony-related Environment Variables

To complete the installation, youmust remove some environment variables set by the previous installation.

IMPORTANT: Please do this with caution.
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1. From the Start menu, select Control Panel.

The Control Panel opens.

2. Double-click on System and select theAdvanced system settings link in the left panel.

3. In the Advanced tab, click Environment Variables.

4. In the System Variables panel, select LM_LICENSE_FILE (if listed) and click Delete to delete LM_
LICENSE_FILE.

5. Delete any of the following variables if they appear in the System or User variables lists:

‣ TOONBOOM_LICENSE_FILE

‣ USADB

‣ USADIR

‣ USAROOT

Backing Up Configuration Files

You also need to back up any necessary configuration files from themachine in case you want to reuse them. You
can also back up the license.dat file as well.

How to back up configuration files

1. Do one of the following:

‣ Version 7.8: Go to \Program Files (x86)\Toon Boom Animation\Harmony 7.8\etc.

‣ Version 7.3: Go to \Program Files (x86)\Toon Boom Animation\Harmony\etc.

‣ Versions 7.2 and earlier: Go to the \usa\etc folder.

2. Back up any of the following configuration files:

‣ Scan.conf if this workstation is to be configured as a scanning station.

‣ VectOptions.conf on anymachine (including the server) that is doing batch vectorization.

‣ Any other.conf file that is required to be used later.

NOTE: You can back up the entire /usa or harmony folder to ensure all configuration file are backed up.

3. Go to the/usa/etc/flexlm folder and back up the license.dat file.

Uninstalling the Previous Version of Toon Boom Harmony or Opus

Now youwill uninstall the previous version of Harmony or Opus.
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How to uninstall the previous version of Harmony or Opus.

1. From the Start menu, select Control Panel.

The Control Panel opens.

2. Double-click on Program and Features and select Harmony orOpus.

3. From the top menu, click Uninstall.

4. Reboot themachine.

5. Back up the database. For the server upgrading process, back up the database by exporting the entire
database. This will prevent you from losing any data during the upgrading process. You can, however,
back up the current /usa_db and /usadata by renaming them (this procedure can only be used when
installing on the same server). This requires extra caution. If you are at all unsure, contact your system
administrator or Toon Boom Support.

Installing Toon Boom Harmony

How to run the installation script

1. Download the build of Harmony that you are going to install.

2. Double-click on the Harmony InstallShield executable. 

3. Select the language for the installer and click OK. This will only affect the language of the installer, not
the Harmony software.

4. In the InstallShieldWelcomewindow, click Next to continue with the installation.

The License Agreement dialog box opens.

5. Read the license agreement and decide if you accept its terms.

‣ If you accept the terms in the license agreement, select I accept the terms in the license
agreement and click Next.

‣ If you do not accept the terms in the license agreement, click I do not accept the terms in the
license agreement and then click Next.

The installation will stop immediately and Toon BoomHarmony will not be installed on your
computer.

The Destination Folder dialog box appears. You can click Cancel to interrupt the installation and then
click Yes to stop the installation completely.

NOTE: You can install Toon Boom Harmony to any location. This document assumes that the installation will be
done at the default location.

6. Select the drive on which you want to install Toon BoomHarmony and click Next.

The Setup Type dialog box appears.
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7. Select the type of installation you want to do. Select theComplete option to install all the HarmonyNet-
work components.
When installing a server, it is possible to do a custom install and install only the server component.
However, it is recommended to always do a full install as this will give you access to all the applications
from the server if need be.

8. Click Next.

The Ready to Install the Program dialog appears.

9. Click Install again to begin the installation.

10. When this process is complete, click Finish.

Configuration
After installing Toon BoomHarmony, you need to configure the database parameters depending on your
machine's setup and third-party software, and restart your anti-virus settings.

1. Configuring Toon BoomHarmony on page 21

2. Sharing Toon BoomHarmony Related Directories on page 26

3. Configuring the License on page 28

4. Turning on the Anti-Virus Software on page 37

Configuring Toon Boom Harmony

You can use the Toon BoomHarmony InstallationWizard at any time to:

• Modify the Toon BoomHarmony server or client configuration

• Configure batch processing

• Configure scanners

• Prepare a client to be the client of a Linux server

• Add Harmony's path to the Path environment variable

After installation, youmust set up the database configuration for computers running Toon BoomHarmony.

1. Setting Up the Database Server on page 22

2. Setting Up the Database Client on page 25

How to start the Toon Boom Harmony Configuration Wizard

1. From the Start menu, select one of the following:

Windows 8: Start > Apps > Harmony [version] [edition] > ConfigurationWizard

Windows 7: Start > All Programs > Harmony [version] [edition] > Tools > ConfigurationWizard

The Toon BoomHarmony Configuration window opens.
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Setting Up the Database Server

TheDatabase Server controls all interactions with the contents of the Toon BoomHarmony database. It
processes all requests to open, read or update files, keeping track of files that are locked so others cannot
edit them.

How to set up the Database Server

1. In the Harmony ConfigurationWizard, click Database.

2. Select the Server/Standalone option and click Next.
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3. Enter the location of the database, and set a user name and password for the user who will be running the
database services. The default account is usabatch. If the account specified does not exist, it will be cre-
ated by the wizard.

NOTE: Make sure to take note of the account name and password if an account other than the default one is used.
This information will be required later on for client workstations to connect to the server.
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4. Click Next.
The USA_DB database is created. The database tracks the location of the scene data on the file system.
You can havemultiple file systems, but only one USA_DB.

NOTE: If you are upgrading from a previous version of Harmony or Opus and you have renamed USA_DB for
backup, you need to create a new USA_DB at the same location where the previous USA_DB was located.

5. In the Scene Data Location window, create the storage locations for the database.

‣ Filesystem: Select the file system youwant to add. The first File system is already created for you. If
you want to create additional file systems to, for example, store scene data across multiple drives or
computers, click Add.

‣ Drive: Select the drive on which you want to create the file system.

‣ Share: In this field is the name of the file system that will be created. You can change this value.
However, it is recommended to leave the default name, which increments from usadata000.

‣ Host Computer: Enter the name of the computer on which this file systemwill be created. By
default, the current computer's name appears here. You can create file systems on other computers
if necessary.

‣ User Name and Password: Specify the user name and password that will be used to connect to the
file system. It is recommended to use the same user name and password as the one used for the
database.

6. Click Next.

The Toon BoomHarmony: Review window opens.
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7. Review the information in the window. If it's correct, click Finish.

Setting Up the Database Client

After you have configured the server, configure all the client machines that will connect to the server. Use the
Toon BoomHarmony ConfigurationWizard to connect client computers to the database.

How to set up the Database client

1. In the Harmony ConfigurationWizard, click Database.

2. In the Database Creation window, select theClient option and click Next.
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3. In the Server Namewindow, enter the name of the Toon BoomHarmony server and click Next.

4. In the Review window, verify the database changes and click Finish.

Amessage appears when the client computer is successfully connected to the database server.

NOTE: It is possible to change the user account used to connect to USA_DB or the different file systems using the
Toon Boom Control Panel, which you can start from Start > All Programs > Harmony 12.1 [edition] > Tools >
Control Panel.

Sharing Toon Boom Harmony Related Directories

Sharing Toon BoomHarmony related directories does not need to be done in a typical installation. This is
required only when the shares were not created correctly during server configuration. For example, this can
happenwhen simple file sharing was not turned off before running the ConfigurationWizard on the server. Or
when you have backed up the usadb and usadata folders before installation, youmay have to share them
when putting them back into place.

NOTE: If you are upgrading from a previous version and changed the USA_DB and USADATA name during upgrade,
make sure to return to the normal names before continuing.

How to activate file sharing for the Toon Boom Harmony folder

1. On your computer, locate the following folder: C:\Program Files (x86)\Toon Boom Anim-
ation\Harmony 12.1 [edition].

2. Right-click on the Toon BoomHarmony 12.1 [edition] folder and select Properties.
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3. Select the Sharing tab.

4. Click Advanced Sharing.

5. Select the Share this folder option.

6. In the Share Name field, type usa.

NOTE: Changing the name of the share to usamust only be done when sharing the Harmony folder. The USA_DB and
USADATA folders should keep their original name.

7. Click Permissions.

The Permissions dialog box displays.
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8. For the Everyone group, set all permissions to Allow and click OK.

9. Back in the File Properties window, select the Security tab.

10. Click Edit to prompt the permissions window. Set all permissions in each group or user to all.

11. Click OK.

12. Repeat steps 3 to 10 with the USA_DB and USADATA folders.

Configuring the License

How to configure the license server

1. From the Start menu, select one of the following:

Windows 8: Start > Apps > Harmony [version] [edition] > LicenseWizard
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Windows 7: Start > All Programs > Harmony [version] [edition] > License Tools > LicenseWizard

The LicenseWizard appears.

2. Click Activate License.

3. Click Internet Activation.

4. Click Network License to activate your Toon Boomproduct on the server.
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NOTE: If you don't have an Internet connection on your server, click Alternative Activation and then see Server
License Email.

5. Enter the product code you received by email.
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6. In the License Count field, enter the exact number of seats associated with your product code. The number
of seats is available below the product code if you have a registration card.

7. Click Activate to start the validation process.

Congratulations! Your Toon Boomproduct is now activated on your server.

8. Click Install License Server to install the License Daemon on your server. By doing so, the License Server
application will automatically start when you turn on your server.
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NOTE: On certain operating systems, you might be asked to enter the administrator password to authorize the
installation of the license daemon.

The license.dat file is created and placed in /usr/local/flexlm/licenses/license.dat. The
license.dat file contains the following information:

SERVER this_host 0 ANY

VENDOR toonboom

USE_SERVER

It will also configure and start the License Server service.

The Activation Successful screen appears.

Your license is successfully set up. You can now quit the LicenseWizard and install your Toon Boom
product on a client workstationmachine.

9. Click Finish to close the LicenseWizard.

10. Look at the lmgrd.log to make sure it was started properly.

C:\flexlm\lmgrd.log

11. From the Start menu, select one of the following:

Windows 8: Start > Apps > Harmony [version] [edition] > FlexLM Tools.

Windows 7: Start > All Programs > Harmony [version] [edition] > License Tools > FlexLM Tools.

12. Verify that the license server has been configured properly and that it is running. Below are the default
parameters for the license service.
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13. It is good practice to verify that the license service it properly running by going in the Server Status tab and
clicking Perform Status Enquiry.

Restoring Backed Up Data

How to restore backed up data

1. Open the Toon Boom Harmony Control Panel and select HarmonyStart0-tbdbserver from the Pro-
cess Starter menu and click Stop.

2. Press Ctrl + Alt + Delete to open the Task Manager. Select the Processes tab and verify that the tbdb-
server is no longer there.

3. Open the File Explorer and rename the new empty USA_DB database folder to USA_DB_NEW .

4. Rename the USA_DB_BAK (the one that was backed up earlier) to USA_DB to restore the previous data-
base.

5. Copy the dicts files from the new database (USA_DB_NEW/dicts) to the one you restored (USA_DB/-
dicts).

NOTE: Dicts files can also be copied from C:\Program Files\Toon Boom Animation x86)\Harmony
12.1\etc\USADB_templates\dicts

6. Share the USA_DB folder giving full control every one. Make sure that simple file sharing is turned off
before doing this.

If you cannot set permissions per use for the share, it means that simple file sharing is turned on.

7. Rename the new empty usadata000 folder (and any other file system folder) to usadata000_NEW.

8. Share the usadata000 folder (and any other folder you have restored) giving full control to everyone.
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9. Start the tbdbserver by opening the Toon Boom Harmony Control Panel. Select HarmonyStart0-
tbdbserver from the list and click Start. After starting the tbdbserver, look at the tbdb-
server.log to make sure it was started properly.

C:\ProgramData\Toon Boom Animation\Toon Boom Harmony

10. Verify that you can open Harmony and scenes from the server.

Setting Up the License on Client Workstations

AnAdmin account is required to set this up. After activation, you can log in as client.

How to set up the license on a client workstation

1. On the client machine, open the LicenseWizard from the Start menu:

Windows 8: Start > Apps > Harmony [version] [edition] > LicenseWizard

Windows 7: Start > All Programs > Harmony [version] [edition] > License Tools > LicenseWizard

The LicenseWizard appears.

2. Click Activate License.

The ActivationOptions screen appears.

3. Click Use License Server.
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The Server Activation screen appears.

4. Click Connect to Server.

The Server Activation - Shared License screen appears.
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5. Enter the license server address that you will access from your workstation. The License server must be
accessible, running and properly configured.

6. In the Port field, enter the port you're using on the server (if applicable) and click Connect.

The Server Activation - Shared License dialog appears.
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7. In the License Server Address field, enter the hostname or the IP Address.

8. Click Connect.

You are prompted for a password.

9. Enter the password and click OK.

10. Click Finish to close the LicenseWizard.

Turning on the Anti-Virus Software

Inform your SystemAdministrator before turning your anti-virus software back on.

How to turn the anti-virus software back on

1. Reactivate virus protection. If your anti-virus software is not detected, open any anti-virus software applic-
ations on your computer and reactivate each onemanually.

Turning on the Firewall

The process to do this is basically the reverse of the procedure used to deactivate the firewall.

Inform your SystemAdministrator before proceeding with this task.

How to turn on the firewall

1. From the Start menu, select Control Panel.

2. Double-click on theWindows Firewall icon.

3. In theWindows Firewall window, click Turn Windows Firewall On or Off on the left side of the window.

The Customize Settings for Each Type of Network dialog box displays.
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4. Select the Turn on Windows Firewall option.

5. Click OK.

Creating Inbound Rules

How to create inbound rules

1. Back in theWindows Firewall window, click theAdvanced Settings link.

2. Click Inbound Rules to display the list of inbound rules.
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3. On the right side of the window, click New Rule.

4. Select the Program option and click Next.

5. Select the This Program Path option and click Browse.
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6. Navigate to the Harmony installation path and select tbdbserver.exe. Click Open.

7. Click Next and select theAllow the Connection option

.

8. Select the profiles for which this rule will be applied according to your network configuration and click
Next.
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9. Finish the Rule creation process by clicking Finish.

10. Repeat steps 1 to 9 for tbprocess.exe and toonboom.exe.

11. If this computer will be used as a license server, repeat steps 1 to 9 for lmgrd.exe.

Troubleshooting
If you have any outstanding issues running Toon BoomHarmony after installation, review the installation and
configuration instructions to make sure you have followed them completely. If you continue to have problems,
consult the following list to troubleshoot common installation and configuration problems.

• Problem: License Error When Starting a Toon BoomHarmonyNode on page 41

• Problem: Unable to Import Sample Scene (Errors with the tbdbserver) on page 42

• Problem: Unable to Open Sample Scene on Clients on page 43

• Problem: resolution.conf Error Message on page 43

Problem: License Error When Starting a Toon Boom Harmony Node

If you are getting license errors when you start a Toon BoomHarmony node, verify the setup and configuration of
the license service.

How to verify the setup and configuration of the license service

1. Make sure that the license.dat file is in the following directory:
C:\flexlm

2. Open the license.dat file; it should contain the following information:

SERVER this_host 0 ANY

VENDOR toonboom

USE_SERVER

3. Make sure that the license service is running.

If you continue having problems with the license server, locate the file ToonBoomLicense.log and send
it to support@toonboom.com. This file is usually in C:\flexlm.
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Problem: Unable to Import Sample Scene (Errors with the tbdbserver)

Check the tbdbserver.log file. It is usually stored in C:\ProgramData\Toon Boom Animation\Toon
Boom Harmony.

If there is no log file, restart the tbdbserver.

How to restart the tbdbserver

1. Open the Harmony Control Panel.

2. Double-click the Toon Boom Harmony Control Panel icon.

The Toon BoomHarmony Control Panel dialog box opens.

3. From the Process Startermenu, select tbdbserver.

4. Click Start.

If you continue to have problems with the database server, locate the tbdbserver.log file and send it
to support@toonboom.com. This file is usually in C:\ProgramData\Toon Boom Animation\Toon
Boom Harmony.

You can also run the Dbserver from the command shell in debugmode to receive additional information about
the process.

How to run the tbdserver in debugmode

1. Open the /USA_DB/Dbserver.conf file.

2. Add the following line to the file:

debug_port 5681

3. Click the Start menu and select All Programs > Harmony 12.1> Configuration Tools > Control Panel.

4. In the Toon BoomHarmony Control Panel window, select tbdbserver from the Process Starter menu
and click Stop.

5. Open a command prompt by selecting Start > All Programs > Accessories > Command Prompt.
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6. Type the following:

tbdbserver -debug

NOTE:While you are running the tbdbserver in debug mode, messages will be written to the shell for each operation
the tbdbserver performs. This is in addition to the information written to the tbdbserver.log file.

7. To output this information to a new file, type the following:

tbdbserver -debug > "C:\ProgramData\Toon Boom Animation\Toon Boom
Harmony\tbdbserver_debug.log"

NOTE: If you still cannot determine the nature of the problem, send the file to support@toonboom.com with a
detailed description of the problem.

Problem: Unable to Open Sample Scene on Clients

If clients cannot open the sample scene, it is possible that they are not connected to the database server. Follow
the instructions for connecting to the server—see Setting Up the Database Server on page 22.

Problem: resolution.conf Error Message

When you open a scene, youmight get an error message that says that the resolution.conf file cannot be
found. This file is usually stored in the environment or job directory of your database. There is a
resolution.conf file you can copy.

How to obtain a copy of the resolution.conf file

1. Open the following folder:

C:\Program Files (x86)\Toon Boom Animation\Harmony 12.1\resources\samples

2. Copy the resolution.conf file to one of the following folder:

‣ \USA_DB\environments\[environment_name]

‣ \USA_DB\jobs\[job_name]

‣ \USA_DB\resolution\

Configuring Harmony Web Control Center on Windows

Running Harmony Web Control Center Manually

HarmonyWeb Control Center is included in your installation of Harmony 12.1.
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How to start the Harmony WebControl Center

1. Navigate to the following directory:

C:\Program Files (x86)\Toon Boom Animation\Toon Boom Harmony 12.1
[edition]\win64\bin

2. Double-click on webcc.bat.

NOTE: You can use the Toon Boom Harmony Installation Wizard at any time to install Harmony Web Control
Center as a service.

Configuring Harmony Web Control Center

Youmust use the Toon BoomHarmony ConfigurationWizard to install HarmonyWeb Control Center and the
Cisco OpenH264 library which enables you see view themovie and thumbnail previews inWeb Control Center.

How to open the Toon Boom Harmony Configuration Wizard

1. From the Start menu, select All Programs > Harmony 12.1 [edition] > Tools > Configuration Wizard.

The Toon BoomHarmony Configuration window opens.

How to install the Cisco OpenH264 library

1. In the Toon BoomHarmony Configuration window, click Harmony WebControl Center Server.

The HarmonyWeb Control Center Center Server window opens.
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2. Select the Yes option and click Next.

3. Review the information in the window. If it is correct, click Finish.

When the ConfigurationWizard is finished, a dialog box opens which indicates the success of the process.

Starting or Stopping the Harmony Web Control Center Service

If at any point you want to start or stop HarmonyWeb Control Center service, you can do so through the
Harmony Control Panel or throughWindows services.
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How to start or stop the Harmony WebControl Center service using the Harmony Control Panel

1. From the Start menu, select All Programs > Harmony 12.1 > Tools > Control Panel.

2. On the Process Starters tab, select HarmonyStarter[x]-webcc.bat from the Process Starter menu.

3. Click Start or Stop to start or stop the service respectively.

How to start or stop the Harmony WebControl Center service usingWindows services

1. From the Start menu, select Control Panel.

2. Depending on your setup, select one of the following:

‣ System and Security > Administrative Tools > Services

‣ Administrative Tools > Services

3. Right-click onHarmonyStarter[x]-webcc.bat and select Start or Stop to start or stop the service.
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Customizing the Harmony Web Control Center Service

You can customize some parameters, such as the default port, for the HarmonyWeb Control Center service.

How to customize the Harmony WebControl Center service

1. From the Start menu, select All Programs > Harmony 12.1 [edition] > Tools > Control Panel.

2. On the Process Starters tab, select HarmonyStarter[x]-webcc.bat from the Process Starter menu.

3. If the service is running, click Stop.

4. Edit the webcc.bat file located in C:\Program Files (x86)\Toon BoomAnimation\Toon BoomHarmony
12.1 [edition]\win64\bin to include your parameters.

For example, to change the default port to 8081:

"%~dp0\bin_3rdParty\node.exe" ..\..\webcc\server\app.js -port 8081%

NOTE: It is possible that you won't have permission to save into the folder. Just copy/paste it on your desktop and
recopy back to the folder as a workaround.

The customizable parameters are:

Parameter Description

-numWorkers n

Number of processes to service client requests. Default is number of CPU
cores. Set to 0 to disable worker child processes. If the number of CPUs is high,
performance could be impacted on all processes running on the server. If server
is mostly for Web Control Center, increase the number for better performance.

-noAuth
Disables basic login/authorization verifications with the user database. Default:
authorization enabled.

- port port The port to which HarmonyWeb Control Center is deployed. Default: 8080.

-http port
Enables http protocol on specified port (can be used along with https to enable
both). Default: http enabled unless -https is also enabled.
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-exchange loc Location (on disk) of top-level file exchange folder. Default: /USA_DB/exchange

-cacheDuration s
Number of seconds to keep data in cache. Default 3600. 0-> disable cache, 1-
999999-> number of seconds to keep data in cache.

-allowAllOrigin
Enables webcc web service from all sources (enable cross-origin resource shar-
ing). Default: Disabled.

-disableAnalytics Disables Google Analytics tracking for all clients. Default: Enabled.

Options Related to SSL Server

-https [port]
Enables https protocol on port 8443, unless a port override is provided.
Default: Disabled.

-key key
<filename> the private key for the SSL session (works with -cert). Default:
None.

-cert cert
<filename> the certificate filename for the SSL session (works with -key).
Default: None.

-pfx file
<filename> alternate filename that includes both the private key and certificate
for the SSL session. Default: None.

5. From the Control Panel, click Start.

Uninstalling the Harmony Web Control Center Service

If you need to uninstall the HarmonyWeb Control Center service, you can do so using the Harmony Control
Panel.

NOTE: A script was added to assist in uninstalling the OpenH264 library on Windows. It is located in the
Configuration Wizard.

How to uninstall the Harmony WebControl Center

1. From the Start menu, select All Programs > Harmony 12.1 > Tools > Control Panel.

2. On the Process Starters tab, select HarmonyStarter[x]-webcc.bat from the Process Starter menu.

3. Click Stop and Remove, then click Delete Process Starter.
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4. Click OK.

Network Setup

If your server does not have an assigned IP address on your DNS server, you should set up a static IP.

Setting Up a Static IP

How to set up a static IP for accessing the Harmony WebControl Center

1. From the Start menu, type cmd and press Enter.

2. In the command prompt that opens, type:

ipconfig /all

3. You will need the following information: IPv4 Address, Subnet Mask, Default Gateway andDNS
Servers.
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4. From the Start menu, select Control Panel.

5. Click View network status and tasks.

6. On the top-left side of the screen, click Change adapter settings.

7. It is possible to havemultiple connections listed. You need to determine which adapter is your con-
nection to the Internet. Right-click on your network adapter and select Properties.

The Local Area Connection Properties opens.

8. Select Internet Protocol Version 4 (TCP/IPv4) and click Properties.

The Internet Protocol Version 4 (TCP/IPv4) Properties dialog box opens.
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9. Select theUse the following IP address option. Enter the IP address, Subnet Mask, and Default Gateway
information you obtained in step 3.

10. Select theUse the followingDNS server addresses option.

11. Enter the DNS addresses you obtained in step 3.

12. Click Advanced.

13. Select theDNS tab.

14. Add the DNS suffix obtained in step 3.
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Opening a Port for External Connection

It is necessary to open a port in your firewall to allow other computers to access the HarmonyWeb Control
Center server. Be default, HarmonyWeb Control Center uses port 8080.

How to open a port for external connection

1. From the Start menu, select Control Panel.

2. Depending on your setup, youmight need to click System and Security beforemoving to the next step.

3. ClickWindows Firewall.

4. On the left pane, click Advanced settings.

TheWindows Firewall with Advanced Security window appears.

6. On the left pane, click Inbound Rules.

7. On the right pane, click New Rule.
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TheNew Inbound RuleWizard appears.

8. Select the Port option and click Next.

9. Select the TCP and Specific local ports options.

10. In the Specific local ports field, type in 8080 and click Next.

NOTE:
You can change the default port used by Harmony Web Control Center by modifying the webcc.bat file—see
Customizing the Harmony Web Control Center Service on page 47.
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11. Select theAllow the connection option and click Next.

12. Select theDomain, Private and Public options and click Next.
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13. In the Name field, type in Toon BoomWebControl Center and click Finish.

Toon BoomWeb Control Center appears in the list of inbound rules.
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Web Browser Notes

For clients of the server, note that as of version 42 of Google Chrome, the standard way in which browsers
support plugins does not work. This means that themore recent Java plugins will not work. If this is the case,
youmust enable the use of NPAPI plugins.

NOTE: Some browsers don't support Java and will have problems opening scenes. The first time you open a scene
in a browser, it might take a long time because it has to set Java.

How to enable the use of NPAPI plugins

1. In a web browser, enter the following:

chrome://flags/#enable-npapi

2. Locate the Enable NPAPI configuration option.

3. Click the Enable link.

4. At the bottom-left of the configuration page, click Relaunch Now.
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Chapter 2: Installing on Mac OS X
This document explains how to install Harmony 12.1 onMacOS X, and assumes that you are familiar withMacOS
X networking and know how to work in a command shell.

Throughout this document, you will be creating files using your favourite text editor. Be sure to convert your files
to plain text before saving them.

There are several stages required to install Harmony 12.1, which are covered in the following topics:

1. Pre-installation on page 57

2. Installing Toon BoomHarmony on page 59

3. Configuration on page 63

4. Configuring Harmony to Share Scene Data on page 76

5. Configuring Harmony Clients on page 85

After completing these stages, you can verify the integrity of the installation and resolve any configuration issues.

• Troubleshooting on page 87

Pre-installation
Before installing Toon BoomHarmony, youmust perform the following tasks:

• Pre-installation on page 57

• Obtaining the Product Code on page 57

• Prerequisites for Harmony Installation on page 58

Verifying the Minimum Requirements

For theminimum hardware requirements, visit: System Requirements.

For themost current Toon BoomHarmony hardware requirements, refer to theHarmony and Your IT
Department white paper available from:

• Toon BoomAnimation Sales Representative

• Toon BoomAnimation Support at: support@toonboom.com.

Obtaining the Product Code

You should obtain a product code from the Toon Boom licensor, so you can finish the installation process without
having to wait for the activation code to arrive.

To obtain a Harmony 12.1 product code, send the following information to: licensor@toonboom.com.

• Your name and the name of your company

• Email address where to send the license file

Editing Files

• When editing files, you can use your favourite text editor. In this guide, all theMacOS X procedures use
the vi text editor.
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• Youmust be logged in using the root account. If not, type sudo before launching the command. For
example:

sudo vi hosts

Prerequisites for Harmony Installation

ADNS server must be configured on the network to be able to run Harmony. All the computers running
Harmonymust be registered with this server or Harmony will not be able to run properly. If a DNS server is not
configured on the network or if Harmony workstations are having problems resolving the name of the server,
the name of the server and each client along with their IP address should be added to the /etc/hosts file on
each computer.

• Editing the hosts File on page 58

• Editing the launchd.conf File on page 59

Editing the hosts File

How to edit the hosts file

1. Make sure the server and all the client workstations are configured with a static (fixed) IP address.

2. Open the Terminal:

/Application/Utilities/Terminal

3. From the Terminal, go to the /etc folder:

cd /etc

4. Create a backup copy of the hosts file.

cp hosts hosts.bak

5. Edit the /etc/hosts file using the vi text editor.

6. Go to the end of the file and add a new line. Type the static IP address and themachine name (host-
name) of the server. Make sure there is a space between the IP address and the hostname.

If there is a domain configured on the network, you should also type the Fully Qualified Domain Name
(FQDN) after the hostname and separate themwith a space.

Example: 192.168.1.1 server server.toonboom.com

To complete this step, add the IP address and the hostname of each workstation that will be a client of
the Harmony server. Each of them should be typed on a new line.

7. Save the exit the file.

The file is written and the system returns you to /etc in the Terminal.

8. Verify the content of the hosts file:

more hosts

9. Copy and paste the hosts file to all the client machines.
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Editing the launchd.conf File

How to edit the launchd.conf file

1. Open the Terminal:

/Application/Utilities/Terminal

2. From the Terminal, go to the /etc folder:

cd /etc

3. If the /etc/launchd.conf file already exists, create a backup copy:

cp launchd.conf launchd.conf.bak

4. Edit the /etc/launchd.conf file using your favourite text editor—see Editing Files on page 57.

5. At the beginning of the file, add a line with the following:

umask 0

6. Save the file aand exit.

The file is written and the system returns you to /etc in the Terminal.

7. Verify the content of the launchd.conf file:

more launchd.conf

Installing Toon Boom Harmony
Now that you have verified theminimum requirements and configured your hardware and software, you are ready
to install Toon BoomHarmony.

You will perform the following tasks:

1. Upgrading from a Previous Installation on page 59

2. Creating the usabatch User on page 61

3. Installing Harmony on page 62

Upgrading from a Previous Installation

If you are not upgrading from a previous installation of Toon BoomHarmony, go to Installing Toon Boom
Harmony on page 59.

If you are performing an upgrade, pick a timewhen Toon BoomHarmony production is slow or stopped. During
the upgrade, no users can run any of the Toon BoomHarmonymodules and all rendering jobs must be stopped
or completed.

How to update previous installations

1. Make sure that no one is running any versions of Harmony or Opus. All Harmony or Opus nodes must be
closed on the server and on all the clients.
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2. Verify that all batch rendering and vectorizing are completed or that the queues are empty. You can
check the status of Vectorize and Render queues from the Control Center module.

‣ In the Control Center module, use theQueuemenu, Environment > Vectorize Queue or Render
Queue to open the Vectorize queue or Rendering queue for each environment. The queue should
either be empty or the status of all jobs should beCompleted.

Be sure to stop the queues on all rendering machines. If the queues are running, those binaries will be
locked and the installer cannot update them.

3. Stop all services running on the server and the clients.

‣ If you are upgrading from version 7.3 to 11.1, type in the Terminal:

sudo /sbin/SystemStarter stop ToonBoomQueueServer

sudo /sbin/SystemStarter stop ToonBoomLinkServer

sudo /sbin/SystemStarter stop ToonBoomDatabaseServer

sudo /sbin/SystemStarter stop ToonBoomLicense

‣ If you are upgrading fromHarmony or Opus 7.2, type in the Terminal:

sudo /sbin/SystemStarter stop USAnimation_queues

sudo /sbin/SystemStarter stop USAnimation_link_srv

sudo /sbin/SystemStarter stop USAnimation_dbserver

sudo /sbin/SystemStarter stop USAnimation_flexlm

4. Go to the applicable folder:

‣ Version 7.8 and later: /Applications/Toon Boom Harmony [version]/tba/etc

‣ Version 7.3: /Applications/Toon Boom Harmony/usa.bundle/etc

‣ Version 7.2: /usa/etc

5. Back up any necessary configuration files:

‣ manager.conf

‣ server.ini if this server is configured to haveWindows clients.

‣ Scan.conf if this workstation is configured to be a scanning station.

‣ VectOptions.conf from anymachine (including the server) that is doing batch vectorization.

‣ Any other configuration file that is required to be used later.

‣ You can back up the entire application folder to ensure that no configuration file is missed.

6. From the Terminal, go to the /usr/local/flexlm/licenses/ folder. If you are upgrading from version 7.2,
go to the /usa/etc/flexlm folder. Back up the license.dat file.

7. Delete the /Applications/Toon Boom Harmony [version] folder or rename it to keep as a
backup.

8. If you are upgrading from a previous version of Harmony or Opus, youmust delete Startup Items from
the previous installation. For example:
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‣ Version 7.3 and later: Delete any folders that begin with ToonBoom, such as
ToonBoomDatabaseServer.

‣ Version 7.2 and earlier: From /Library/StartupItems/, delete any folders that begin with
USAnimation, such as USAnimation_dbserver.

NOTE: Depending on the server and client configuration, you might not see any folders starting with Toon Boom or
USAnimation.

Deleting Files in Each User's Home

If you are upgrading fromHarmony or Opus, youmust also delete extra files that are located in each user's home.

How to delete files in each user's home

1. Open the Terminal:

/Application/Utilities/Terminal

2. Go to a user's home that was configured to work with Harmony. Using the usabatch account as an
example:

cd /Users/usabatch

3. List all the files in usabatch's home:

ls -lsa

4. Look for a folder named .MacOSX in the list of files and folders that appear.

5. If the folder is there, delete it:

sudo rm -rf .MacOSX

6. Repeat these steps for each user that was configured to work with a previous version of Harmony.

Creating the usabatch User

Before you install Harmony, youmust create the usabatch user account on the server and on all the
workstations that will performing batch processing (computers that will be part of the batch rendering or
vectorizing farm). A number of services, including the tbdbserver, license server and batch processing are started
using the usabatch account.

The usabatch account must have administrator rights on the computer.

NOTE: If you are upgrading from a previous version of Harmony or Opus, you may not need to create the usabatch
account since you will use the same account that was created from the previous installation.
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How to create the usabatch user account

1. Open System Preferences. By default, there is a shortcut for System Preferences in theDock.

2. In the System panel of the System Preferences dialog box, click Users & Groups.

The Password tab of the Accounts window opens.

3. To make changes to the accounts on a MacOS X, click the lock icon at the bottom of the window. Enter
your username and password for an account that has administrator privileges.

4. Click the plus (+) sign button to add a new user.

5. Give the new user the following name, account name and password:

usabatch

The usabatch account name and password must be in all lower-case letters.

6. Select Administrator from themenu next toNew Account.

7. Click Create User.

8. Once the account is created, open the Terminal and log in as the usabatch user:

su -l usabatch

9. Make sure you're in the home folder of usabatch, then edit or create the .profile for usabatch:

vi .profile

10. Make sure the file contains the following lines:

#!/bin/bash

umask 0

11. Save and exit the file.

Installing Harmony

In a client-server network or in a standalone setup, youmust install Harmony, as well as the following services
on the server or the standalone computer:

tbdbserver Controls access to the database.

License service Controls the number of licenses and features available to Harmony users.

Batch processing Controls batch vectorizing and rendering queues.

Link server
If you are installing Harmony on a MacOS X server that will support Win-
dows clients, youmust install the Link server.

To install Harmony programs and services, youmust run the installation package. Before you start the
installation, make sure you are currently logged in the systemwith administrator rights on your local computer.
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How to get administrator privileges

1. Open System Preferences. By default, there is a shortcut for System Preferences in theDock.

2. In the System Preferences dialog box, click Users & Groups.

The Password tab of the Accounts window opens.

3. Select your user login account and verify if theAllow user to administer this computer option is selected.
To make changes to the accounts on a MacOS X, click the lock icon at the bottom of the window. Enter
your username and password for an account that has administrator privileges.

How to install Harmony

1. Double-click the Harmony .dmg file.

2. Drag the Toon BoomHarmony 12.1 folder from the .dmg file to theApplications folder.

3. In the window that opens, click Accept.

Configuration
After installing Harmony, configure the database parameters and the third party software based on the role this
computer will have.

• Configuring Harmony on page 63

• Configuring the Licensing on page 70

Configuring Harmony

Once Harmony is installed, additional steps are required to configure the database on the server and to set up
the startup items and register the application path for the Terminal.

Setting Up the Database Server

The database server controls all interactions with the contents of the Toon BoomHarmony 12.1 database. It
processes all requests to open, read or update files, keeping track of files that are locked so others cannot edit
them.

If you already have a database set up from a previous installation of Toon BoomHarmony 12.1, youDONOT
need to set up the database server, startup items, or register console application in the path. However, if you are
upgrading from a previous version, you need to install the startup items and register console applications in the
path. For new installations of Harmony, youmust install all of them.

How to configure the database server using the Configuration Assistant

1. From Finder, go to Applications > Toon Boom Harmony [version] [edition] > Tools.

2. Double-click onConfiguration Assistant.

If you are upgrading from a previous version and a database (/USA_DB) already exists on the server,
deselect theCreate a new Toon Boom Harmony database option.
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3. For the server, select all the options if this is the first time you are installing on this machine.

If you are upgrading from an earlier version of Toon BoomHarmony 12.1, update the dict files in the
/USA_DB. Copy the dict files from here:/Applications/Toon Boom Harmony 12.1
[version]/tba/etc/USADB_templates/dicts/ to /USA_DB/dicts/.
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4. Click Continue.

The Create Harmony Database screen opens. The default values shown should be correct.
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5. Click Create.

NOTE:
You can always create the Toon Boom Harmony 12.1 database manually later. To do so, open the Terminal and
type the following:

cd /

mkdir usadata000

chmod -R 777 usadata000

NOTE: You must be logged in using the root account. If not, type sudo before launching the command.

You canmake as many data directories as needed. Name these directories using the following syntax, where
XXX represents the number of the data directory:

usadataXXX
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NOTE: If you want to use a name other than usadataXXX for the Toon Boom Harmony 12.1 database, edit the
Manager.conf file and add the name or search pattern for this new database. The Manager.conf file can be edited
using the Configuration Editor in the Tools folder of your Toon Boom Harmony 12.1 installation. Open the
Configuration Editor and select theManager.conf tab.

6. In the Create Startup Item screen, select the startup items required.

Parameter Description

Create Database Server Startup Item It is mandatory to install this on the server.

Create Link Server Startup Item
This is required when there will beWindows clients connecting to
theMac server. This service creates symbolic links when a scene is
created from aWindows client workstation.

CreateQueue Server Startup Item
This is for the batch rendering. Do not install this on the server, as it
will slow it down. Install this on a standalonemachine used for batch
vectorizing or rendering.

Create HarmonyWeb Control Center
Server Startup Item
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Your startup items are created.

7. Click Create.

The following screen opens.

8. Enter your username and password, and click OK.

The Register Path screen opens.
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9. Register the path for the current user or for all users. This option appends the path of Harmony's applic-
ations to the PATH environment variable in order to run the applications from the Terminal.

Parameter Description

Registration Path for all users
Registers the path for all accounts on the computer. You only need
to run this once.

Registration Path for my user only
Registers the path to the current account only. You need to run this
for each user that will be using the Terminal and you need to run this
each time you create a new user.

10. Click Create.

The Cisco OpenH264 Library screen opens.

11. Select the Install OpenH264 Library option and click Create.

The server is successfully configured.
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12. Click Done to close the Configuration Assistant.

Configuring the Licensing

The licensing must be configured before running Toon BoomHarmony 12.1.

Youmust perform the following tasks on the server:

• Setting Up the FlexLM License Server on page 70

• Setting Up the License on Client Workstations on page 74

Setting Up the FlexLM License Server

IMPORTANT: For existing installations, you must reinstall Harmony on your license server machine in order for
FlexLM to work properly.

How to configure the license server

1. Start the LicenseWizard fromApplications > Toon Boom Harmony [version] [edition] > Tools >
LicenseWizard.

TheWelcome screen appears.
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1. Click Activate License.

The ActivationOptions screen appears.

2. Click Internet Activation.

The Internet ActivationOptions screen appears.
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3. Click Network License.

The Internet Activation - Network License screen appears.

4. Do the following:

‣ In the Product Code field, enter your product code.

‣ In the License Count field, enter the number of licenses the product code grants you.
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NOTE: Once activated and returned to the activation server, a server license cannot be activated again. Make sure
you are activating the license on the correct computer with the proper license count.

5. Click Activate.

The Install License Server screen appears.

6. Click Install License Server.

The license.dat file is created in /usr/local/flexlm/licenses/license.dat. The License Server is also
configured and started.

The license.dat created contains the following:

SERVER this_host 0 ANY

VENDOR toonboom

USE_SERVER

The Activation Successful screen appears.

7. Click Finish to exit the wizard.
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If you're having problems with the license, try the folllowing:

‣ Reread the license file:

lmreread -a

‣ Verify that the FlexLM license is working properly:

lmstat -a

You can also look at the ToonBoomLicense.log file:

/tmp/ToonBoomLicense.log

‣ If the FlexLM service needs to be restarted:

sudo launchctl unload
/Library/LaunchDaemons/com.toonboom.LicenseServer.plist

sudo launchctl load
/Library/LaunchDaemons/com.toonboom.LicenseServer.plist

Setting Up the License on Client Workstations

NOTE: An Admin account is required for setting up the license on the client workstations. After activation you can
login as client.
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How to set up the license on a client workstation

1. Open the License Wizard on the client workstation.

The Toon BoomActivationWizard appears.

2. Click Activate License.

The ActivationOptions screen appears.

3. Click Use License Server.
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The Server Activation screen appears.

4. Click Connect to Server.

The Server Activation - Shared License screen appears.

5. In the License Server Address field, enter the hostname or IP Address.

6. Click Connect.

You are prompted for a password.

7. Enter the password and click OK.

The Activation Successful screen appears.

8. Click Finish to close the LicenseWizard.

Configuring Harmony to Share Scene Data
Before you can share scene data between a MacOS X database andMacOS X, Linux, andWindows clients,
youmust configure theMacOS X database server appropriately.

• Sharing Harmony Directories for MacOS X and Linux Clients on page 77
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• Setting Up the Server for Windows Clients on page 78

Sharing Harmony Directories for Mac OS X and Linux Clients

Toon BoomHarmony 12.1 uses NFS (Network File System) to share files betweenMacOS X and Linux
computers. Youmust use NFS to export directories from the server so clients canmount them and share the
contents.

Sharing the Database for Mac OS X and Linux Clients

If your MacOS X server will haveMacOS X or Linux clients, youmust export the USA_DB and USADATA folders
using NFS. The clients will then need to be configured to mount those exported folders from the server.

Setting Up NFS Exports on Mac OS X

The following procedure shows you how to export the /USADATA and /USA_DB directories on a MacOS X
workstation, as NFS shared points.

How to set upNFS exports on MacOS X

1. From the Finder, go to Applications > Utilities and double-click on Terminal.

2. Create and edit the exports file in the /etc directory:

sudo vi /etc/exports

3. Add the following:

/USA_DB -maproot=nobody

/USADATA -maproot=nobody

4. Save and exit the file.

5. Verify that the file is correct by running:

sudo nfsd checkexports

If there is no return response, then it is correct.

6. Start nfsd:

sudo nfsd enable

7. If nfsd was already started, notify the nfsd daemon that the /etc/exports file has changed:

sudo kill -1 `cat /var/run/mountd.pid`

NOTE: The back quote (`) character is located at the top-left of the Mac OS X keyboard on the same key as the tilde
(~) character. Or simply reboot the computer.
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8. Verify that the folders exported correctly:

/usr/bin/showmount -e

The following should appear:

/USA_DB Everyone

/USADATA Everyone

Once the export file is created, client systems canmount /USA_DB and /USADATA located on theMac
OS X server system.

Setting Up the Server for Windows Clients

If Windows clients are going to access the Toon BoomHarmony 12.1 database on a MacOS X server, you
must set up the Link Server, Samba and the server.ini file. These allow the server and clients to communicate
and share data.

• Configuring and Starting the Link Server on page 78

• Configuring Samba onMacOS X on page 79

• Configuring the server.ini File on page 84

• Rebooting the Server on page 84

Configuring and Starting the Link Server

If you are running Toon BoomHarmony 12.1 in a mixed environment where the server is onMacOS X and
some of the clients are runningWindows, youmust start the Link Server, whichmakes it possible for Windows
machines to communicate with the database.

How to configure the Link Server on the server in a mixed network environment

1. If you did not already install the Link Server during the server installation, youmust do it now. From the
Finder, go to Applications > Toon Boom Harmony [version] [edition] > Tools.

2. Double-click on theConfiguration Assistant.

3. Select Create the Startup Items and deselect the other options.

4. Click Continue.

5. InCreate Startup Item, select Create Link Server Startup Item.

6. Click Create.

7. Enter a user name and password of a user with administrator rights and click OK.

The installation will start Link server automatically.

8. A log file is generated in /tmp/com.toonboom.LinkServer.log. Check this file to make sure there
are no errors.
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NOTE: To help troubleshoot, you might need to stop or start Link server.

Start Link Server: sudo launchctl load /Library/LaunchDaemons/com.toonboom.LinkServer.plist

Stop Link Server: sudo launchctl unload /Library/LaunchDaemons/com.toonboom.LinkServer.plist

Configuring Samba on Mac OS X

Do the following:

• Configuring the Samba Service on page 79

• Configuring the Samba Shared Files on page 81

• Configuring the smb.conf File on page 83

IMPORTANT: Mac no longer uses the open source Samba software to share folders for Windows workstations. It has
been replaced by Apple's own Windows file sharing software, which does not include some of the options required to
support Windows Harmony clients.

Configuring the Samba Service

By default, Samba is not set up to run automatically onMacOS X.

How to start the Samba service

1. Open System Preferences.

2. In the Internet & Wireless section, click Sharing.

3. In the Services section, select the File Sharing option.
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4. In the Shared Folders section, click the plus (+) sign.

5. Browse and select the /USA_DB folder.

6. Repeat steps 4 and 5 for the /USADATA folder.

7. Make sure to give the usabatch account Read andWrite permissions to the USA_DB and USADATA
folders.
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8. Click Options.

9. Select the Share files and folders using SMB option.

10. Select the usabatch option and click Done.

11. Close System Preferences.

Configuring the Samba Shared Files

Next, modify the /USA_DB and /USADATA shares in the /var/db/samba/smb.shares and add a usa section
to the file.

1. Open the Terminal.

2. In the Finder, go to Application > Utilities and double-click on Terminal.

3. Go to the samba directory:

cd /var/db/samba/

4. Open the smb.shares file.

sudo vi smb.shares

5. Add or modify options in the file.

The following is an example of entries in the smb.shares shared file. You can addmissing options at the
end of the list.

[USA_DB]

comment = Harmony database folder

path = /USA_DB
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available = yes

guest ok = no

directory mask = 777

create mask = 777

browseable=yes

read only=no

[USADATA]

comment = Harmony USADATA filesystem

path = /USADATA

available = yes

guest ok = no

directory mask = 777

create mask = 777

browseable=yes

read only=no

6. Create a [USA] share bymaking a copy of the [USA_DB] section and pasting it underneath.

7. Rename [USA_DB] to [USA].

8. Modify the following lines under [USA]:

path = /Applications/Toon Boom Harmony 12.1/tba

comment = Harmony binaries and configuration files

9. Verify that the [USA] section looks like the following:

[usa]

comment = Harmony binaries and configuration files

path = /Applications/Harmony 12.1/tba

available = yes

guest ok = no

directory mask = 777

create mask = 777

browseable = yes

read only = no

10. Save and exit the file.
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Configuring the smb.conf File

Youmust also add or modify the following entries to the [global] section of the /etc/smb.conf file.

1. Create a backup copy of your current /etc/smb.conf file:

cd /etc

sudo cp smb.conf smb.conf.bak

2. Open the smb.conf file.

sudo vi /etc/smb.conf

3. Add or modify options in the file:

[global]

map to guest = Never

dos charset = 437

unix charset = UTF-8-MAC

display charset = UTF-8-MAC

blocking locks = false

oplocks = false

mangled names = no

NOTE:When set to no, the mangled names parameter will prevent older smb clients (DOS, Win9X andWindows NT
clients) from accessing files and folders that do not have an 8.3 file name.

4. Save and exit the file.

5. Verify that you have not made any basic syntax errors:

testparm

6. Notify the smbdservice of the changes:

sudo kill -1 `cat /var/run/smbd.pid`
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NOTE: The back quote (`) character is located at the top-left of the Mac OS X keyboard on the same key as the
tilde (~) character. Or simply reboot the computer.

Configuring the server.ini File

Before you install Toon BoomHarmony 12.1 onWindows clients, youmust create the server.ini file on the
server. The server.ini file provides information necessary inWindows for theConfiguration Wizard to set
up a Windows client.

NOTE:When creating the server.ini file, be attentive to spelling, character spacing and case.

How to create the server.ini on the Mac server

1. From the Finder, go to Applications > Toon Boom Harmony [version] [edition] > Tools and double-
click on theConfiguration Editor.

2. In the Configuration Editor opens, click the server.ini tab.

3. Copy and paste the following example and modify it accordingly:

This is an example of the server.ini file whose server name is harmonyserver. Also there is one
directory named USADATA.

[WizardConfig]

ServerName=harmonyserver

InstallationDrive=C

UsaShare=usa

UsadbDrive=C

UsadbShare=USA_DB

FileSystem0=C USADATA harmonyserver

NOTE: The references to the C: drive in this example are necessary for Windows clients and will be ignored by
Mac OS X.

4. From the File menu, select Save and quit the Configuration Editor.

Rebooting the Server

At this point, reboot the server so all of the services which you have just configured will start up.
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Configuring Harmony Clients
The following procedure demonstrates how to mount the /USADATA and the /USA_DB server directories, on a
MacOS X 10.6 or 10.7 workstation, as NFS Shared points.

To mount NFS Export onMacOS X 10.6 and 10.7, clients do the following:

• Renaming Existing /USA_DB and /USADATADirectories on page 85

• Configuring theMounts Using the Disk Utility on page 85

Renaming Existing /USA_DB and /USADATA Directories

IMPORTANT: This only applies if you already have a /USA_DB and a /USADATA local directory.

Before starting, youmust rename these directories if you want to keep their contents.

How to rename the local /USA_DB and /USADATA directories

1. Open the Terminal.

1. From the Finder, go to Application > Utilities and double-click on Terminal.

2. Rename the local USA_DB and USADATA directories:

sudo mv /USA_DB /USA_DB.BAK

sudo mv /USADATA /USADATA.BAK

Configuring the Mounts Using the Disk Utility

How to configure the mounts using the Disk Utility

1. In the Finder, go to Application > Utilities and double-click onDisk Utility.

2. In Disk Utility, click on File > NFS Mounts.

TheNFSMounts window opens.
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3. In NFSMounts screen, click the plus (+) button on the lower-right corner.

4. In the Remote NFS URL field, type the following line. Replace [server name] by the name of the server.
For example, if the server name is jarjar, you would type: nfs://jarjar/USA_DB.

nfs://[server name]/USA_DB

5. In theMount Location field, type the following:

/Volumes/USA_DB

6. If the workstation is going to connect to a Linux server, edit theAdvancedMount Parameters:

resvport

7. Click Verify.

8. Click OK on themessage that confirms that the NFS server is functional.

9. Repeat steps 3 to 8, but enter the following for the RemoteNFS URL andMount Location:

nfs://[server hostname]/USADATA

/Volumes/USADATA

10. Click Save and enter your user password to confirm the changes.
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NOTE: On Mac OS X 10.7, there is no Save button. Changes are automatically saved and applied when the NFS
Mounts window is closed.

11. Quit theDisk Utility.

12. Open a new Terminal window.

13. Verify that the /USA_DB and /USADATA shared points have beenmounted properly:

ls /Volumes/USA_DB

and

ls /Volumes/USADATA

14. Create symbolic links to the USA_DB and USADATA directories at the root level /

sudo ln -s /Volumes/USA_DB /USA_DB

sudo ln -s /Volumes/USADATA /USADATA

15. Verify that the symbolic links are pointing to the right directories:

ls -l /

The symbolic links for the /USA_DB and /USADATA should look like the following:

USADATA -> /Volumes/USADATA

USA_DB -> /Volumes/USA_DB

Troubleshooting
If you have any outstanding issues running Toon BoomHarmony after installation, review the installation and
configuration instructions to make sure you have followed them completely. If you continue to have problems,
consult the following list to troubleshoot common installation and configuration problems.

• Problem: Unable to Open Sample Scene on Clients on page 87

• Problem: License Error When Starting Any HarmonyNode on page 88

• Problem: Unable to Import Sample Scene (Errors with the Dbserver) on page 88

• Problem: resolution.conf Error Message on page 89

Problem: Unable to Open Sample Scene on Clients

On the Toon BoomHarmony 12.1 server, verify the following:

• The database and data directories were exported using NFS.

• Link Server, Samba and server.ini configurations for Windows clients.

• OnMacOS X Toon BoomHarmony 12.1 clients, verify that the database and data directories were
mounted using NFS.
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Problem: License Error When Starting Any Harmony Node

If you are getting license errors when you start a Toon BoomHarmony 12.1 node, verify the setup and
configuration of the license service.

How to verify the setup and configuration of the license service

1. If you are using a license server, verify that the license.dat file is in the following directory:
/usr/local/flexlm/licenses

2. Open the license.dat file. It should contain the following:

SERVER this_host 0 ANY

VENDOR toonboom

USE_SERVER

NOTE: On a client workstation, the license server hostname should be on the first line instead of this_host.

3. On theMac license server, open theActivitymonitor and make sure that the lmgrd and Toon Boompro-
cesses are running. If both of them aremissing, start the license service by typing the following in the
Terminal:

sudo launchctl load
/Library/LaunchDaemons/com.toonboom.LicenseServer.plist

4. If you get an error message when you try to start the license service, it is possible that you did not install
the license Startup Item. Use the LicenseWizard to install the license server Startup Item.

5. If you continue having problems with the license server, locate the file ToonBoomLicense.log and
send it to support@toonboom.com. The file is located in: /tmp.

Problem: Unable to Import Sample Scene (Errors with the Dbserver)

• Verify the com.toonboom.DatabaseServer.log file located in /tmp. If there is no log file, start the
Dbserver. Type the following in the Terminal:

sudo launchctl load
/Library/LaunchDaemons/com.toonboom.DatabaseServer.plist

If there is a log file, the last few lines will give you some indication as to the problemwith the Dbserver.

• If you get an error in the log about themachine name, verify the
/USA_DB/Dbserver.conf file and make sure the hostnamematches themachine name of the Toon
BoomHarmony 12.1 server.

• If you get errors about the port number, another servicemight be using port 5680. You can change the
port number in Dbserver.conf to any unused number above 5000.

• Restart the Dbserver. Type the following in the Terminal:

sudo launchctl unload
/Library/LaunchDaemons/com.toonboom.DatabaseServer.plist
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sudo launchctl load
/Library/LaunchDaemons/com.toonboom.DatabaseServer.plist

Problem: resolution.conf Error Message

When you open a scene, youmight get an error message that says that the resolution.conf file cannot be
found. This file is usually stored in the environment or job directory of your database. There is a
resolution.conf file you can copy.

How to obtain a copy of the resolution.conf file

1. Open the following folder:

/Applications/Toon Boom Harmony [version][edition]/tba/resources/samples

2. Copy the resolution.conf file to one of the following folder:

‣ /USA_DB/resolution

‣ /USA_DB/environments/[environment_name]

‣ /USA_DB/jobs/[jobs_name]

Configuring Harmony Web Control Center on Mac OS X

Configuring Toon Boom Harmony Web Control Center

How to install Harmony WebControl Center as a service

1. From Finder, go to Applications > Harmony 12.1 > Tools.

2. Double-click onConfiguration Assistant.

TheWelcome screen opens.
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3. Select theCreate the Startup Items and Install/Uninstall Cisco OpenH264 Library options and click
Continue.

The Create Startup Item screen opens.

4. Select theCreate Harmony WebControl Center Server Startup Item option and click Create.

Amessage box opens.

5. Click OK.

The Cisco OpenH264 Library screen opens.
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6. Select the Install OpenH264 Library option and click Create.

The Finish screen opens.

7. Click Done.

8. Open the Terminal and start the service:

sudo launchctl load
/Library/LaunchDaemons/com.toonboom.WebCCServer.plist

NOTE: A script was added to assist in uninstalling the OpenH264 library on Mac. It is located in the Configuration
Assistant.
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Managing the Harmony Web Control Center Service

If at any point you need to start/stop or restart the HarmonyWeb Control Center server, you can do so
through launchctl inMacOS X.

Start the service
sudo launchctl load
/Library/LaunchDaemons/com.toonboom.WebCCServer.plist

Stop the service
sudo launchctl unload
/Library/LaunchDaemons/com.toonboom.WebCCServer.plist

Alternatively, you can start or stop all Harmony services with the following commands:

Start all services
/Applications/Toon Boom Harmony 12.1 [edition]
/tba/macosx/bin/Startus

Stop all services
/Applications/Toon Boom Harmony 12.1[edition]
/tba/macosx/bin/Stopus

Customizing the Harmony Web Control Center Service

You can customize some parameters, such as the default port, for the HarmonyWeb Control Center service.

How to customize the Harmony WebControl Center service

1. Stop the service if it is active—seeConfiguring HarmonyWeb Control Center onMacOS X on page 89.

2. Open the following file:

/Applications/Toon Boom Harmony 12.1 [edition]/tba/macosx/bin/webcc.sh

3. After the last character, add HarmonyWeb Control Center parameters after the last character.

#!/bin/sh -f

# Script to start Harmony Web Control Center server

DIRNAME=$(dirname "$0")

cd "$DIRNAME"

./bin_3rdParty/node ../../cloud/server/app.js "$@"

The customizable parameters are:

Parameter Description

-numWorkers n

Number of processes to service client requests. Default is number of CPU
cores. Set to 0 to disable worker child processes. If the number of CPUs is
high, performance could be impacted on all processes running on the server.
If server is mostly for Web Control Center, increase the number for better
performance.

-noAuth
Disables basic login/authorization verifications with the user database.
Default: authorization enabled.

- port port The port to which HarmonyWeb Control Center is deployed. Default: 8080.
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-http port
Enables http protocol on specified port (can be used along with https to
enable both). Default: http enabled unless -https is also enabled.

-exchange loc
Location (on disk) of top-level file exchange folder. Default: /USA_DB/ex-
change

-cacheDuration s
Number of seconds to keep data in cache. Default 3600. 0-> disable cache, 1-
999999-> number of seconds to keep data in cache.

-allowAllOrigin
Enables webcc web service from all sources (enable cross-origin resource
sharing). Default: Disabled.

-disableAnalytics Disables Google Analytics tracking for all clients. Default: Enabled.

Options Related to SSL Server

-https [port]
Enables https protocol on port 8443, unless a port override is provided.
Default: Disabled.

-key key
<filename> the private key for the SSL session (works with -cert). Default:
None.

-cert cert
<filename> the certificate filename for the SSL session (works with -key).
Default: None.

-pfx file
<filename> alternate filename that includes both the private key and cer-
tificate for the SSL session. Default: None.

4. Save and close the file.

5. Start the service—seeConfiguring HarmonyWeb Control Center onMacOS X on page 89.

Running Harmony Web Control Center Manually

If you do not want to run HarmonyWeb Control Center as a service, you have the option to manually start the
HarmonyWeb Control Center server.

How tomanually run Harmony WebControl Center

1. Open the Terminal and go to /Applications/Harmony 12.1 [edition]/tba/macosx/bin.

2. Run ./webcc.sh.

NOTE:
You can change the default port used by Harmony Web Control Center by modifying the webcc.sh file. Use your
favourite text editor to open the file and add the following at the end:

-port [port]
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NOTE: You can change the default port used by HarmonyWeb Control Center by modifying the webcc.sh. Open
the file using a text editor and add the value of the parameter and the desired value. See the following text:

#!/bin/sh -f
# Script to start Harmony Web Control Center serverDIRNAME=$(dirname "$0")
cd "$DIRNAME"
./bin_3rdParty/node ../../cloud/server/app.js "$@" -port 8081

Other parameters can be customized—see Configuring Harmony Web Control Center on Mac OS X.

Network Setup

Setting Up a Static IP

Youwill need to set up a static IP for accessing the HarmonyWeb Control Center application.

How to set up a static IP

1. Open the System Preferences window.

2. Click Network.

3. From the Locationmenu, select Edit Locations.

4. Click the plus sign (+) and enter an appropriate name. Click Done.
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5. Configure your static IP with information pertaining to your connection and click Apply.

Opening a Port for External Connection

To allow other computers to access your HarmonyWeb Control Center server, it is necessary to open a port in
your firewall. HarmonyWeb Control Center uses port 8080 by default.
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How to open a port for external connection

1. Open the System Preferences window.

2. Click Sharing.

3. Click the lock icon at the bottom of the window to enable editing.

4. Enter your password when prompted.

5. Click Security.

6. Click the lock icon at the bottom of the screen to enable editing.

7. Enter your password when prompted.

8. Click Turn Off Firewall.

9. Close the System Preferences window.

Web Browser Notes

For clients of the server, you can start Stage from Safari by changing its preferences to run Java in unsafemode
for localhost. Safari added -per-site controls for each applet.

NOTE: Some browsers don't support Java and will have problems opening scenes. The first time you open a scene
in a browser, it might take a long time because it has to set Java.
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How to run Java in unsafe mode

1. Go to the Safari > Preferences > Security page.

2. ClickManage Website Settings for Internet plugins, then select Java.

3. For the desired site entry (eg. localhost if runningWeb Control Center server locally) select the Run in
Unsafemode.
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Chapter 3: Installing on Linux
This chapter explains how to install Harmony 12.1 on Linux CentOS, and assumes that you are familiar with Linux
and working in a command shell.

Throughout this document, you will be creating files using a text editor. The vi text editor is commonly used and
is part of the CentOS package. Another text editor you can use is nano. To start them, just type their name on
the command line.

There are three stages required to install Harmony, which are covered in the following topics:

1. Pre-installation on page 99

2. Installing a New System on page 112

3. Configuration on page 115

After completing these steps, verify the integrity of the installation and resolve any configuration issues.

Pre-installation
Before installing Toon BoomHarmony, youmust perform the following tasks:

• Verifying theMinimumRequirements on page 99

• Obtaining the Product Code on page 99

• Checking Your Pre-installation Configuration on page 99

Verifying the Minimum Requirements

For theminimum hardware requirements, visit: System Requirements.

For themost current Toon BoomHarmony hardware requirements, refer to theHarmony and Your IT
Department white paper available from:

• Toon BoomAnimation Sales Representative

• Toon BoomAnimation Support at: support@toonboom.com.

Obtaining the Product Code

You should obtain a product code from the Toon Boom licensor, so you can finish the installation process without
having to wait for the activation code to arrive.

To obtain a Harmony 12.1 product code, send the following information to: licensor@toonboom.com.

• Your name and the name of your company

• Email address where to send the license file

Checking Your Pre-installation Configuration

Configure your computer before installation by performing the following tasks:

• Installing CentOS on page 100

• Disabling SELinux on page 100

• Updating theNVIDIA Drivers on page 101

99

http://docs.toonboom.com/help/system-requirements/Content/System_Requirements/HAR_12_SystemRequirements.html
mailto:support@toonboom.com?subject=Harmony and Your IT Department White Paper
mailto:licensor@toonboom.com?subject=Toon Boom Harmony 10 Product Activation Code


Chapter 3: Installing on Linux

• Resolving Keyboard Conflicts on page 101

Installing CentOS

Following are some considerations for CentOS Linux installation. Explaining how to install CentOS Linux is
beyond the scope of this document—refer to the CentOS documentation.

How to Install CentOS

1. Download the CentOS Linux documentation from: http://wiki.centos.org/documentation

2. Before installing Linux, make sure the distribution you will be installing is 64-bit. Harmony 12.1 will not
work if theOS is not 64-bit.

3. When installing CentOS Linux, perform a Custom installation and select to install Everything to ensure
that you get all the packages necessary to run Harmony.

4. When prompted, select Firewall as disabled. Your file server should be behind a firewall, but not be con-
figured as one.

5. When prompted, select SELinux as disabled.

Harmony has been tested and certified for use on theGNOME windows manager.

Harmony works best with a minimum screen resolution of 1280 pixels x1024 pixels x 24-bit. If CentOS
cannot detect your monitor, configure themonitor as a generic CRT or an LCD with this resolution and
a 60 Hz refresh rate. Alternatively, consult your monitor manufacturer's documentation.

If you are new to Linux, it is recommended that you create a boot disk to facilitate recovery.

Disabling SELinux

How to disable SELinux

1. Verify if SELinux is enabled by reviewing the contents of the SELinux config file:

more /etc/selinux/config

2. Locate the line that starts with SELINUX= and verify that the value is set to disabled:

# This file controls the state of SELinux on the system.

# SELINUX= can take one of these three values:

# enforcing - SELinux security policy is enforced.

#   permissive - SELinux prints warnings instead of enforcing.

# disabled - No SELinux policy is loaded.

SELINUX=disabled

# SELINUXTYPE= can take one of these two values:

# targeted - Targeted processes are protected.

# mls - Multi Level Security protection.
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SELINUXTYPE=targeted

3. If the value is set to something other than disabled, open the file using a text editor and change the
value to disabled.

4. Once the file is modified and saved, reboot the computer.

Updating the NVIDIA Drivers

Youmust install the recommended drivers for your NVIDIA video card, otherwise Harmony will not function.

In general, you should use the latest drivers. New drivers tend to resolve past driver issues. If you already have
NVIDIA drivers installed, find the version number by typing:

cat /var/log/Xorg.0.log | grep "X Driver"

How to install the NVIDIA driver

1. Download the Linux driver from theNVIDIA website:

www.nvidia.com/object/unix.html

2. As a root user, switch to text modewhen installing video card drivers.

/sbin/init 3

3. Install the NVIDIA kernel driver.

sh /[path_to_driver_file]/NVIDIA-Linux-x86_64-[driver_name].run

4. Once theNVIDIA driver installation is successful, revert to graphical mode by starting X.

/sbin/init 5

OR

startx

IMPORTANT: Some recent Linux distributions include an open source driver for NVIDIA graphic cards called
"Nouveau". This driver must be disabled in order to install the NVIDIA drivers—refer to the NVIDIA documentation.

Resolving Keyboard Conflicts

Some default keyboard shortcuts conflict with the shortcuts in Harmony and can prevent normal user operation.

How to change the keyboard shortcuts

1. In themenu, go to System > Preferences > Windows.

TheWindow Preferences dialog box opens.

2. In the Movement Key section, select the Super (or "Windows logo") option.
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Upgrading From a Previous Installation of Toon Boom Harmony

At this point, it is assumed that the USAnimation, Opus or Toon BoomHarmony binaries (program files) are
installed on the Toon BoomHarmony server and aremounted by all the Linux clients. When you update the
installation on the server, all clients will load the new binaries from the central mount point.

When performing an upgrade, pick a timewhen Toon BoomHarmony production is slow or stopped. During
the upgrade, no users can run any of the Toon BoomHarmonymodules and all rendering jobs must be
stopped or completed.

• Restoring Backed Up Files on page 104

• Editing usabatch's .cshrc on page 104

• Editing Other Users' .cshrc on page 104

• Editing the /etc/skel/.cshrc on page 105

• Configuring the License Server on page 105

• Restarting the Harmony Services on page 109

• Updating the nfs Export on page 109

• Updating the smb.conf on page 110

• Verifying the Parameters Required in the smb.conf File on page 111

How to update previous installations

1. Verify that no one is running any versions of USAnimation, Opus or Toon BoomHarmony. All of their
nodes must be closed on the server and all the clients.

2. Verify that all batch rendering and vectorizing are completed or that the queues are empty. You can
check the status of Vectorize and Render queues from the Control Center module.

‣ In the Control Center module, use theQueuemenu, Environment > Vectorize Queue or Render
Queue to open the Vectorize queue or Rendering queue for each environment. The queue should
either be empty or the status of all jobs should beCompleted.

3. Stop all services running on the server and the clients. Depending on the services you have running, type
the following commands in the order presented:

/etc/init.d/USAnimation_queues stop

/etc/init.d/USAnimation_link_srv stop

/etc/init.d/USAnimation_dbserver stop

/etc/init.d/USAnimation_flexlm stop

NOTE:
Some recent Linux distributions include an open source driver for NVIDIA graphic cards called "Nouveau". This
driver must be disabled in order to install the NVIDIA drivers—refer to the NVIDIA documentation.It's not necessary
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to delete the startup scripts from /etc/init.d/ as the Harmony install script will update them automatically.

It's important to stop the queues on all rendering machines. If the queues are running, those binaries will be locked
and the installer cannot update them.

4. Back up Harmony's configuration files by copying them to a location where you can recover them later. Go
to the folder where the previous version of Harmony is installed and back up the configuration files in the
etc folder:

‣ Version 7.8 and later: /usr/local/ToonBoomAnimation/harmony_[version]/etc

‣ Version 7.5 and earlier: /usa/etc

Back up the following configuration files:

Manager.conf

Scan.conf (If a scanner was configured to run with the Harmony Scan node on this computer)

server.ini (If the server is configured to receive connections fromWindows clients)

VectOptions.conf (If a vectorization preset had been added to it)

If plug-ins were added to the Harmony installation, back up these files as well.

‣ Version 10.0 and later: /usr/local/ToonBoomAnimation/harmony_[version]/lnx86_
64/plugins

‣ Version 7.8 and 9.2: /usr/local/ToonBoomAnimation/harmony_[version]
/lnx86/plugins

‣ Version 7.5 and earlier: /usa/lnx86/plugins

You can back up the entire Harmony folder by renaming it to make sure all config files are kept.

5. Clean themenu. The shortcut to start the previous application should be removed from themenu. There
are two ways to do this:

‣ Delete them from the command line by doing the following:

Change to:

cd /usr/share/applnk

Delete the old shortcuts:

Version 7.8 and later: rm ToonBoom-Harmony_*

Version 7.5 and earlier: rm USAnimation-*

The shortcuts will be removed from themenu the next time you log in.

6. Uncompress the distribution file:

tar xvfz [path_to_distribution_file]/[filename].tar.gz

7. Switch to the directory that was extracted from the tar.gz file.

8. Run the install script specifying the options required for your server.
./install -b -d -l -p -u -kde

Parameter Description
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-b This is mandatory. This installs the binaries required to run Harmony.

-c
Installs HarmonyWeb Control Center as a service. This parameter is required if this machine
is the HarmonyWeb Control Center server.

-d Configures the tbdbserver for auto startup. Required when installing a server.

-l Configures the Link_srv for auto-startup. Required if the server has Windows clients.

-p Configures the tbprocess for auto-startup. Required if the server will perform batch
processing.

-u Updates the dict files in the /USA_DB/dicts. This is mandatory when upgrading a server
from a version previous to Harmony 12.1. This option will only work if -d is also selected.

-kde Installs Harmonymenu shortcuts in the KDE menu.

Restoring Backed Up Files

1. Copy the server.ini, Manager.conf and any other files you backed up to the new installation: /us-
r/local/ToonBoomAnimation/harmony_12.1/etc/

Editing usabatch's .cshrc

Before you can start the Harmony services, youmust makemodifications to the .cshrc in usabatch's home.

How to edit the usabatch's .cshrc

1. If you are not logged in as usabatch, type the following:

su -  usabatch

2. Open the .cshrc file in usabatch's home:

vi .cshrc

3. Edit .cshrc.

if ( -f /usr/local/ToonBoomAnimation/harmony_12.1/etc/usa_cshrc ) then

source /usr/local/ToonBoomAnimation/harmony_12.1/etc/usa_cshrc

endif

umask 0

4. Save and quit.

Editing Other Users' .cshrc

The.cshrc of all other users of Harmony should be edited to remove the lines that are used to source the
usa_cshrc file. It is not required to source this file any longer as the path to the application was added to the
PATH variable via the files in /etc/profile.d.
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How to edit other users' .cshrc

1. Remove the following line if it exists:

Versions 7.8 and 9.2:

source /usr/local/ToonBoomAnimation/harmony_[version]/etc/usa_cshrc

Version 7.3:

source /usa/etc/usa_cshrc

Editing the /etc/skel/.cshrc

1. Open the file /etc/skel/.cshrc (if it exists) and remove the lines that source the usa_cshrc file.

Configuring the License Server

1. Start Harmony.

TheWelcome screen appears.

1. Click Activate License.

The ActivationOptions screen appears.

2. Click Internet Activation.
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The Internet ActivationOptions screen appears.

3. Click Network License.

The Internet Activation - Network License screen appears.

4. Do the following:

‣ In the Product Code field, enter your product code.

‣ In the License Count field, enter the number of licenses the product code grants you.
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NOTE: Once activated and returned to the activation server, a server license cannot be activated again. Make sure
you are activating the license on the correct computer with the proper license count.

5. Click Activate.

The Install License Server screen appears.

6. Click Install License Server.
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The license.dat file is created in /usr/local/flexlm/licenses/license.dat. The License Server is also
configured and started.

The license.dat created contains the following:

SERVER this_host 0 ANY

VENDOR toonboom

USE_SERVER

NOTE:
Both steps can be done manually if needed.

‣ To configure the License Server to start automatically at boot:

/sbin/chkconfig/USAnimation_flexlm on

‣ To start the License Server manually:

/etc/init.d/USAnimation_flexlm restart

The Activation Successful screen appears.

7. Click Finish to exit the wizard.

8. Verify that the FlexLM license is working properly:

lmutil lmstat -a

You can can also look at the log:

less /tmp/lmgrd.log

If the FlexLM service needs to be restarted:

/etc/init.d/USAnimation_flexlm restart
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Restarting the Harmony Services

How to restart the Harmony services

1. Once the license is properly configured and started, start the Harmony services that are required on your
server in the following order:

/etc/init.d/USAnimation_dbserver restart

/etc/init.d/USAnimation_link_srv restart

/etc/init.d/USAnimation_queues restart

2. Check the logs to verify that the services started properly.

/tmp/lmgrd.log

/tmp/tbdbserver.log

/tmp/tbprocess.log

/tmp/Link_srv.log

3. Start Harmony and open a scene to see if the server works properly.

Updating the nfs Export

If the Linux server has Linux or MacOS X clients, the nfs exports need to be updated with the path of the new
Harmony binaries.

/etc/exports

How to update the nfs export

1. If it exists, change the path of /usa to /usr/local/ToonBoomAnimation/harmony_12.1

/USA_DB *(rw,sync)

/usadata000 *(rw,sync)

/usr/local/ToonBoomAnimation/harmony_12.1 *(rw,sync)

2. Run the following command so the change takes effect:

/usr/sbin/exportfs -r

3. Test the exports:

/usr/sbin/showmount -e

Export list for [hostname].toonboom.com:

/USA_DB *

/usadata000 *

/usr/local/ToonBoomAnimation/harmony_12.1 *
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Updating the smb.conf

How to update the smb.conf file

1. When upgrading a Linux server, a small modificationmust bemade to the usa share path to point to
the new install. "/etc/samba/smb.conf" and change the path under the [usa] share to the path of
the new Harmony install.

[usa]

comment = Harmony binaries & stuff

browseable = yes

read only = no

guest ok = no

create mask = 0777

directory mask = 0777

path = /usr/local/ToonBoomAnimation/harmony_12.1

2. Once the file is saved, verify that you have not made any basic syntax errors.

testparm

Load smb config files from /etc/samba/smb.conf

Processing section "[homes]"

Processing section "[printers]"

Processing section "[USA_DB]"

Processing section "[usa]"

Processing section "[usadata000]"

Processing section "[tmp]"

Loaded services file OK.

Server role: ROLE_STANDALONE

3. Press Enter to see a dump of your service definitions.

NOTE:
Some recent Linux distributions include an open source driver for NVIDIA graphic cards called "Nouveau". This
driver must be disabled in order to install the NVIDIA drivers—refer to the NVIDIA documentation. If the smb.conf
was configured according to the 7.3 documentation, the testparm command may return the following error:

Level II oplocks can only be set if oplocks are also set.

To get rid of this error, add the level2 oplocks = No parameter in the global section of the smb.conf—see
Verifying the Parameters Required in the smb.conf File on page 111 for all the parameters required in the
smb.conf.

4. Restart smb:
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/etc/init.d/smb restart

Verifying the Parameters Required in the smb.conf File

It is always a good idea to verify the configuration of the smb.conf file.

How to verify the parameters required in the smb.conf file

1. Verify the configuration of the smb.conf.

/etc/samba/smb.conf

Parameters needed in the [global] section:

encrypt passwords = no

blocking locks = no

oplocks = no

level2 oplocks = no

follow symlinks = yes

unix extensions = no

wide links = yes

Default parameters for the shares:

[USA_DB]

comment = Toon Boom Harmony Database

browseable = yes

read only = no

guest ok = no

create mask = 0777

directory mask = 0777

path = /USA_DB

[usa]

comment = Toon Boom Harmony binaries & stuff

browseable = yes

read only = no

guest ok = no

create mask = 0777

directory mask = 0777

path = /usr/local/ToonBoomAnimation/harmony_12.1
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[usadata000]

comment = Toon Boom Harmony data 000

browseable = yes

read only = no

guest ok = no

create mask = 0777

directory mask = 0777

path = /usadata000

2. Always perform a testparm after making changes to the smb.conf.

testparm

3. Restart the smb service.

/sbin/service smb restart

4. Reboot the server, if possible, to verify that all the services are properly started.

5. Once the server is booted, check all the logs to see if the services are running properly.

/tmp/lmgrd.log

/tmp/tbdbserver.log

/tmp/tbprocess.log

/tmp/Link_srv.log

Installing a New System
After you have installed CentOS Linux, youmust create the usabatch user account in whichmany Toon Boom
Harmony services run.

Then you can install Harmony. There are a number of options you can choose fromwhen installing Harmony.

Creating the usabatch User

With CentOS Linux installed, you will create the usabatch user account. Youmust also set the usabatch
user to use the tcsh shell and create a .cshrc file to start the Toon BoomHarmony environment whenever
the user logs on.

Youmust create user accounts for all Toon BoomHarmony users. All user accounts you create on CentOS
Linux that will also run Harmonymust be set up in the sameway as the usabatch account, except for the user
name and password.

How to create user accounts

1. In a shell, log in as the root user.

2. Using a text editor, create the file /etc/skel/.cshrc. This file should contain the following line:

umask 0
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NOTE: The above character is a zero.

3. Create the user usabatch.

useradd -m -s /bin/tcsh -r usabatch

NOTE: Make sure tcsh is installed in /bin/tcsh. If it is not, install it using yum install tcsh.

4. Enter the password for user usabatch.

passwd usabatch

Then, type usabatch as a password.

To create additional users repeat steps 3 and 4, replacing usabatch with the user name and password of the
new user.

NOTE: Setting umask to zero (0) ensures that Toon Boom Harmony users can read and write all files in the database,
which is essential for sharing their work.

5. If you are not logged in as usabatch:

su - usabatch

6. Open the .cshrc file in usabatch's home. The .cshrc file should contain the following:

if ( -f /usr/local/ToonBoomAnimation/harmony_12.1/etc/usa_cshrc ) then

source /usr/local/ToonBoomAnimation/harmony_12.1/etc/usa_cshrc

endif

umask 0

7. Save and quit.

8. Log out of usabatch to return to the root user.

Installing Harmony

In a client-server network or in a standalone setup, youmust install Harmony binaries and the following services:

l Dbserver: Controls access to the Harmony database.

l License Service: Controls the number of licenses and features available to Harmony users.
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l Batch Processing: If you are setting up themachine for batch processing, this controls batch vectorizing
and rendering queues.

l Link Server: If you are installing Harmony on a Linux server that will support Windows clients.

To install Harmony binaries and services, youmust run the installation script. With the product activation code
in hand, you are ready to install Harmony.

How to run the installation script

1. Uncompress the distribution file.

tar xvfz [path_to_distribution_file]/[filename].tar.gz

2. Change to the directory that was extracted from the tar.gz file.

3. Run the install script as the root user, specifying the options required for your server. There are a num-
ber of options that control the installation process. For a typical Harmony server or a standalone
machine, run the installation script with the following parameters:

./install -b -d -kde

With these options, the binaries are installed, and the database server is installed and set up to start
automatically. These options also add Harmony entries to the applicationmenu.

If your Linux server will be servingWindows clients, add the -l option.

If you are setting up the clients for batch rendering, add the -p parameter. It is not recommended to
configure batch processing on the server as it will slow it down.

Installation Options

Option Default Value Details

-binaries

-b
Inactive

Installs binaries and configuration files
required to run Harmony applications.

Include this option when performing a
fresh install or when you upgrade
Harmony.

Use option when installing Harmony on
the server.

-cloudserver

-c
Inactive

Installs Harmony Cloud as a service.
This parameter is required if this
machine is the Harmony Cloud web
server.

-dbserver

-d
Inactive

Installs the tbdbserver as a daemon.
This is the Harmony database server
daemon. It processes data requests
from clients on the network.

This option also creates a fresh
database when there is no /USA_DB
directory.
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Option Default Value Details

Use this option when installing
Harmony on the server and on the
standalonemachine.

-help

-h
Inactive Displays script usage information.

-kde Inactive
Adds Harmony entries to the KDE
applicationmenu.

-linkserver

-l
Inactive

Installs the link_server daemon.

This daemon is required for Linux or
IRIX servers to create symbolic links for
Windows clients.

If you haveWindows clients, youmust
install this daemon on the server.

-process

-p
Inactive

Installs the process daemon.

The process daemonmanages batch
processing (vectorizing and rendering)
for Harmony. Usually several
computers participate in the batch
processing pipeline.

This parameter is required if this
computer is going to batch process
files for Harmony.

-quiet

-q
Inactive

Does not output any information
during installation.

-target
<DIRECTORY>

-t
<DIRECTORY>

/usr/local/
ToonBoomAnimation/harmony_
12.1

Directory where the installer will install
the harmony_12.1 tree.

-udatedict

-u
Inactive

Updates the dict files in the database.
Needs to be specified when upgrading
from a previous version.

-webccserver

-w
Inactive

Installs theWeb Control Center as a
daemon.

Configuration

After installing Harmony, configure the database parameters depending on your machine's setup and configure
third-party software.

1. Configuring the Licensing on page 116
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2. Configuring Harmony on page 119

Configuring the Licensing

Now that you have installed Harmony, youmust set up the licensing so it can run on the server and client
machines.

TheWelcome screen appears.

1. Click Activate License.

The ActivationOptions screen appears.

2. Click Internet Activation.
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The Internet ActivationOptions screen appears.

3. Click Network License.

The Internet Activation - Network License screen appears.

4. Do the following:

‣ In the Product Code field, enter your product code.

‣ In the License Count field, enter the number of licenses the product code grants you.

117



Chapter 3: Installing on Linux

NOTE: Once activated and returned to the activation server, a server license cannot be activated again. Make sure
you are activating the license on the correct computer with the proper license count.

5. Click Activate.

The Install License Server screen appears.

6. Click Install License Server.
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The license.dat file is created in /usr/local/flexlm/licenses/license.dat. The License Server is also
configured and started.

The license.dat created contains the following:

SERVER this_host 0 ANY

VENDOR toonboom

USE_SERVER

Configuring Harmony

After installation, set up the database configuration for computers running Harmony.

1. Setting Up the Database Server on page 119

2. Creating the Toon BoomHarmony File System on page 120

Setting Up the Database Server

TheDbserver controls all interactions with the contents of the Toon BoomHarmony database. It processes all
requests to open, read or update files, keeping track of locked files so they cannot be edited by anyone.

When installing Harmony on the server for the first time, the Harmony database folder is created automatically.
Verify that the folder was created correctly. Look for the USA_DB folder in the root folder /USA_DB. If you do not
see the folder, then create it using the create_usa_db script:

/usr/local/ToonBoomAnimation/harmony_12.1/lnx86_64/bin/create_usa_db
/USA_DB

Next, create and edit the Dbserver.conf file to set up the Dbserver. Then run a script to start it.
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How to set up the Dbserver

1. Using a text editor, create the Dbserver.conf file in /USA_DB/.

2. Type the following in the Dbserver.conf file:

Assuming themachine name of the Dbserver is harmonyserver , the lines in Dbserver.conf would
look like this:

hostname harmonyserver

port 5678

debug_port 5680

NOTE: You can find the example of Dbserver.conf in /usr/local/ToonBoomAnimation/harmony_
12.1/resources/samples. You can copy and paste it from there and change it accordingly.

3. Save and close the Dbserver.conf file.

4. Change the permissions on the Dbserver.conf file to 644.

chmod 644 Dbserver.conf

5. Start the Dbserver service.

/sbin/service USAnimation_dbserver start

Amessage appears in the shell indicating that the script was successful. A log file is generated in
/tmp/tbdbserver.log.

6. Verify the log file to ensure there are no errors written to the log.

Creating the Toon Boom Harmony File System

After you set up and start the license and Dbserver, you are ready to create the file system for the Toon Boom
Harmony database.

How to create the Toon Boom Harmony file system

1. Change directories to the root:

cd /

2. Create the following directory:

mkdir usadata000

3. Change the permission of:

/usr/local/ToonBoomAnimation/harmony_12.1 /USA_DB and /usadata000 to
777.
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chmod -R 777 /usr/local/ToonBoomAnimation/harmony_12.1 /USA_DB
/usadata000

You are now ready to test your installation on the server/standalonemachine.

Configuring Harmony to Share Scene Data

This section shows you how to share the Harmony scene data for different network configurations.

• Exporting Harmony Directories for MacOS X and Linux Clients on page 121

• Configuring the Link Server on page 122

• Configuring Samba on page 122

Exporting Harmony Directories for Mac OS X and Linux Clients

Before you can install Harmony on Linux clients, youmust export the Toon BoomHarmony directories from the
server. TheNFS and NFS locking services must be running so that all machines can access the data directories you
export.

How to start NFS services and export data directories from the server

1. To share files with other Linux machines, start the NFS service:

/etc/init.d/nfs restart

/sbin/chkconfig nfs on

2. TheNFS lock manager must run on all Linux stations on your network. Without this service, users cannot
access the database without receiving numerous "read lock"  error messages.

/etc/init.d/nfslock restart

/sbin/chkconfig nfslock on

Now you are ready to export the Toon BoomHarmony directory.

3. Use a text editor to edit the /etc/exports file. Add the names /USA_DB,
/usadata000 and /usr/local/ToonBoomAnimation/harmony_12.1 directories to the file:

/USA_DB *(rw,sync)

/usadata000 *(rw,sync)

/usr/local/ToonBoomAnimation/harmony_12.1 *(rw,sync)

4. Run the export command to finalize the exports:

/usr/sbin/exportfs -r

5. Verify what is being exported from the server:

/usr/sbin/showmount --exports

A report appears listing all the shares exported from the server.
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Configuring the Link Server

If you are running Harmony in a mixed environment where the server is on CentOS Linux and some of the
clients are runningWindows, youmust start the Link Server.This server makes it possible for Windows
machines to communicate with the database.

How to configure the Link Server on the server in a mixed network environment

1. Use a text editor to create the Link_srv.conf file in the /USA_DB directory. This file must contain the
following:

hostname harmonyserver

port 5679

Replace harmonyserver with the name of the database server. You can find the name of a computer
by using the uname -n command.

NOTE: You can find the example of Link_srv.conf under /usr/local/ToonBoomAnimation/harmony_
12.1/resources/samples/. Copy and paste it from there and change it accordingly.

2. Change the permissions on the Dbserver.conf file to 644.

chmod 644 Link_srv.conf

3. Start the Link Server.

/etc/init.d/USAnimation_link_srv start

Amessage appears in the shell indicating that the script was successful. A log file is generated in
/tmp/Link_srv.log.

4. Verify this file to ensure there are no errors written to it.

Configuring Samba

Finally, modify the /etc/samba/smb.conf file. To do this, add entries for each database directory you want
to share withWindows clients in the /etc/samba/smb.conf file. Then, add options to the [global]
section of the file.

• Configuring the Samba Service to Start at Boot Time on page 124

• Configuring the server.ini File on page 124

• Rebooting on page 125

• Setting Up Linux Clients on page 125

• Installing the Start ApplicationMenu Entries and Batch Processing on Clients on page 126

The following is an example of entries in the smb.conf file. You can add these to the end of the file.

[USA_DB]

comment = Toon Boom Harmony Database
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browseable = yes

read only = no

guest ok = no

create mask = 0777

directory mask = 0777

path = /USA_DB

[usa]

comment = Toon Boom Harmony binaries & stuff

browseable = yes

read only = no

guest ok = no

create mask = 0777

directory mask = 0777

path = /usr/local/ToonBoomAnimation/harmony_12.1

[usadata000]

comment = Toon Boom Harmony data 000

browseable = yes

read only = no

guest ok = no

create mask = 0777

directory mask = 0777

path = /usadata000

[usadata001]

comment = Toon Boom Harmony data 001

browseable = yes

read only = no

guest ok = no

create mask = 0777

directory mask = 0777

path = /usadata001/

Youmust also add or modify the following entries to the [global] section of smb.conf:

[global]

encrypt passwords = no
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blocking locks = no

oplocks = no

level2 oplocks = no

follow symlinks = yes

unix extensions = no

wide links = yes

Once you havemade all the changes and saved the smb.conf file, validate the file for internal correctness:

testparm

Configuring the Samba Service to Start at Boot Time

By default, Samba is not set up to run automatically.

How to start the Samba service

1. Configure Samba to run as a service at boot time:

/sbin/chkconfig smb on

2. Start the Samba service:

/sbin/service smb start

Configuring the server.ini File

Before you install Harmony onWindows clients, youmust create the
/usr/local/ToonBoomAnimation/harmony_12.1/etc/server.ini file on the database server. The
server.ini file provides information necessary for theWindows ConfigurationWizard to set up a Windows
client.

When creating the server.ini file, pay attention to the spelling, character spacing and case.

The following is an example of the/usr/local/ToonBoomAnimation/harmony_
12.1/etc/server.ini file. In this example, the database server name is harmonyserver and there are
two usadata directories: usadata000 and usadata001.

[WizardConfig]

ServerName=harmonyserver

InstallationDrive=C

UsaShare=usa

UsadbDrive=C

UsadbShare=USA_DB

FileSystem0=C usadata000 harmonyserver
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FileSystem1=C usadata001 harmonyserver

Do not worry about the references to Drive = C. They are necessary for Windows clients and will be ignored by
Linux.

NOTE: You can find the example of server.ini under /usr/local/ToonBoomAnimation/harmony_
12.1/resources/samples. You can copy and paste it from there and change it accordingly. Any sharing folder
name should be case sensitive.

Rebooting

At this point, you should reboot the Toon BoomHarmony server to verify that all the Harmony services are
properly configured to start automatically.

Setting Up Linux Clients

To run Toon BoomHarmony on Linux clients, youmust mount the binaries and data directories stored on the
server. To access the directories exported from the server, the network file server (NFS) and NFS locking services
must be running.

How to start NFS services andmount Toon Boom Harmony directories on clients

1. To access themounted directories, start the NFS service:

/etc/init.d/nfs restart

/sbin/chkconfig nfs on

2. TheNFS lock manager must run on all Linux stations on your network. Without this service, users cannot
access the database without receiving numerous "read lock" error messages.

/etc/init.d/nfslock restart

/sbin/chkconfig nfslock on

You are now ready to mount the directories from the server.

3. On each client computer, create directories for:

/usr/local/ToonBoomAnimation/harmony_12.1

/USA_DB

/usadata000

The directory names must match the names on the Toon BoomHarmony server.

mkdir /usr/local/ToonBoomAnimation/harmony_12.1

mkdir /USA_DB

mkdir /usadata000
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4. To mount the directories on the client machine, edit the /etc/fstab file. In the following example, the
server is themachine name of the database server.

server:/USA_DB /USA_DB nfs rw,soft,intr,bg 0 0

server:/usadata000 /usadata000 nfs rw,soft,intr,bg 0 0

server:/usr/local/ToonBoomAnimation/harmony_12.1
/usr/local/ToonBoomAnimation/harmony_12.1 nfs rw,soft,intr,bg 0 0

This will make the Toon BoomHarmony directories mount with the default version of NFS on your
system.

If you encounter errors, try using NFS version 2. In this case, you should modify the fstab file to match
the following:

server:/USA_DB /USA_DB nfs rw,soft,intr,bg,vers=2 0 0

server:/usadata000 /usadata000 nfs rw,soft,intr,bg,vers=2 0 0

server:/usr/local/ToonBoomAnimation/harmony_12.1
/usr/local/ToonBoomAnimation/harmony_12.1 nfs rw,soft,intr,bg,vers=2 0
0

5. At a command line, type themount all command.

mount -av

To verify that all shares aremounted:

mount

A report appears listing all the shares mounted on the client.

6. To test that themount works, open one of themounted directories and list the contents.

cd /usr/local/ToonBoomAnimation/harmony_12.1

ls

A list appears of the directories in Harmony 12.1:

etc help lang lnx86 lnx86_64 Plugins resources

Installing the Start Application Menu Entries and Batch Processing on Clients

To make it easier for users to start Toon BoomHarmony, install the applicationmenu entries. You should also
include the -p installation option to start batch processing services on rendering machines.

How to install menu entries and batch processing

1. Go to the directory that contains the Linux installation files.

2. Run the install script with the -p and -kde options.

./install -p -kde
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Troubleshooting
If you have any outstanding issues running Toon BoomHarmony after installation, review the installation and
configuration instructions to make sure you have followed them completely. If you continue to have problems,
consult the following list to troubleshoot common installation and configuration problems.

• License Error When Starting Any HarmonyNode on page 127

• Unable to Import Scene (Errors with the Dbserver) on page 128

• Exported Directories Not Mounting on Clients on page 128

• StageWill Not Open or Crashes on Startup on page 128

• Unable to Display Images in Stage on page 129

• Unable to Open Scene on Linux Clients on page 129

• Resolving Keyboard Shortcut Conflicts and Tweaking KDE on page 129

• Problem: resolution.conf Error Message on page 130

License Error When Starting Any Harmony Node

If you are getting license errors when you start a Toon BoomHarmony node, verify the setup and configuration of
the license service.

How to verify the setup and configuration of the license service

1. If you are using a license server, verify that the license.dat file is in the following directory:
/usr/local/flexlm/licenses

2. Open the license.dat file. It should contain the following:

SERVER this_host 0 ANY

VENDOR toonboom

USE_SERVER

NOTE: On a client workstation, the license server hostname should be on the first line instead of this_host.

3. Verify that the license service is running on the license server.

/sbin/service USAnimation_flexlm status

4. If it is not running, start the service.

/sbin/service USAnimation_flexlm start

5. Restart the Dbserver if the license server was not properly installed or activated.

/sbin/service USAnimation_dbserver restart

6. If you continue having problems with the license server, locate the file lmgrd.log and send it to sup-
port@toonboom.com. This file is usually in /tmp.
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Unable to Import Scene (Errors with the Dbserver)

• Verify the Dbserver.log file. It is usually stored in /tmp.

If there is no log file, restart the Dbserver.

/sbin/service USAnimation_dbserver restart

If there is a log file, the last few lines in the file will give you an indication as to the problemwith the Dbserver.

• If you get an error in the log about themachine name, verify the /USA_DB/Dbserver.conf file and
make sure the hostnamematches themachine name of the Harmony server.

• If you get errors about the port number, verify that the port name in the Dbserver.conf file is not
used by another service. Type netstat -a to see a list of port numbers used by themachine. If
another service is using port 5678, change the port number in Dbserver.conf to any unused number
above 5000.

• Restart the Dbserver.

/sbin/service USAnimation_dbserver restart

Exported Directories Not Mounting on Clients

Onmost Fedora Linux distributions, the ypbind service is started after nfs by default. This causes directory
mounting to fail when your system boots up. This will prevent Linux clients frommounting Toon Boom
Harmony directories from the server.

Youmust verify that the ypbind service is started before nfs.

How to configure the start sequence of ypbind and nfs

1. Turn the service off and remove it from the startup configuration.

/sbin/service ypbind stop

/sbin/chkconfig ypbind off

2. Edit the ypbind startup script located in /etc/init.d/ypbind. Find the following line:

chkconfig: 27 73

Change it to:

chkconfig: 24 73

3. Restart the service.

/sbin/service ypbind start

/sbin/chkconfig ypbind on

Stage Will Not Open or Crashes on Startup

Periodically, Stage does not open and displays anNVIDIA error message in the shell. This may not happen all
the time. Users may report this error after running the application several times successfully.

TheNVIDIA error message directs users to instructions in the Readme file:

/usr/share/doc/NVIDIA_GLX-1.0/README.txt
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Problems with the security node of the PAM system can cause these periodic problems. Follow the instructions in
the NVIDIA Readme to resolve this error.

If you continue to experience problems, verify that the xorg.conf file (in /etc/X11/) contains the correct
driver information (the driver should be nvidia, not nv).

If this does not resolve the problem, reinstall your NVIDIA driver.

Unable to Display Images in Stage

Your monitor's screen settings must be set to 24-bits per pixel.

Verify your current settings.

• If you are using Fedora, verify the file /etc/X11/xorg.conf.

Unable to Open Scene on Linux Clients

• On the Harmony server, verify that all the Harmony directories were exported. The /USA_DB,
/usr/local/ToonBoomAnimation/harmony_12.1, and /usadata directories must appear in the
/etc/exports file. Verify that the entries in this file match the name of the directories you created on the
server.

Verify that the directories have been exported.

/usr/sbin/exportfs -r

• On the Linux client, verify that you created the data directories and mounted the server directories into
those directories. Verify the /etc/fstab file to see that the data directories are listed and spelled the
sameway as the directories on the client and the server.

List the contents of themounted directories to see that there are some contents.

cd /usr/local/ToonBoomAnimation/harmony_12.1

ls

A list appears of the directories in /harmony_12.1. They are:

etc help lang lnx_86 lnx86_64 Plugins resources

• If you do not see anything in the exported directories, verify that the server directories aremounted.

mount -a

If you are able to list the contents of the exported directories and open the sample scene after manually
mounting all shares, verify the start up sequence of ypbind and NFS to verify that NFS is started first—
see Exported Directories Not Mounting on Clients on page 128.

Resolving Keyboard Shortcut Conflicts and Tweaking KDE

Some KDE default keyboard shortcuts conflict with the shortcuts in Harmony and can prevent normal user
operation.

How to change the keyboard shortcuts and tweak KDE

1. In the KDE menu, select Computer > System Settings. In earlier versions of KDE, youmay need to open
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the KDE Control Center.

2. In the System Settings window, selectWindows Behavior in the Desktop section (in earlier versions of
KDE, open the Look & Feel > Window Behaviormenu instead).

3. Select theWindowActions tab.

4. In the Inner window, title bar and frame section, do one of the following:

‣ Change your keyboard layout to chooseMeta key from theModifier Key option. TheMeta key is the
Windows Start button on a 104-key keyboard. Youmust have this type of keyboard to use this
option.
Go to Desktop > Window Behavior (in earlier versions, open the Look & Feel > Window Behavior
menu). Select theActions tab. In the Inner window, title bar and frame section, select Meta as the
Modifier Key.

• If theMeta key is not available in theModifier Key list, youmust change your keyboard layout. This is
set inControl Center > Regional and Accessibility > Keyboard Layout (in earlier versions, open the
Control Center > Peripherals > Keyboardmenu). Select the Enable keyboard layouts option and
then select a KeyboardModel that includes 104 keys.

‣ Set all theModifier Key + options to Nothing.

5. There are a few KDE preferences you should update to optimize Harmony.

‣ In the KDE menu, select Computer > System Settings >Window Behavior. Select theMoving tab
to disable these two options. Harmony reacts better and faster when these are disabled.

• Display content inmoving windows

• Display content in resizing windows

‣ In the KDE menu, select Computer > System Settings > Appearance and select theColorsmenu.
Under theOptions tab, disable the following option: Apply colours to non-KDE4 applications.

NOTE: This option may cause Harmony to display incorrect colours in some of the interface controls.

Problem: resolution.conf Error Message

When you open a scene, youmight get an error message that says that the resolution.conf file cannot be
found. This file is usually stored in the environment or job directory of your database. There is a
resolution.conf file you can copy.

How to obtain a copy of the resolution.conf file

1. Open the following folder:

/usr/local/ToonBoomAnimation/harmony_12.1/resources/samples

2. Copy the resolution.conf file to one of the following folder:

‣ /USA_DB/resolution

‣ /USA_DB/environments/[environment_name]

‣ /USA_DB/jobs/[jobs_name]
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Configuring Harmony Web Control Center on Linux

Installing Harmony Web Control Center

When installing HarmonyWeb Control Center, youmust add options to the Harmony install script command line
and install the Cisco OpenH264 library to see themovie previews and thumbnails.

NOTE: A script was added to assist in uninstalling the OpenH264 library on Linux. It is located at /lnx86_
64/bin/openh264_control.sh.

How to install Harmony WebControl Center as a service

1. Add the following options to the Harmony install script command line.

If you are upgrading HarmonyWeb Control Center server, youmust first stop the service—seeNetwork
Setup on page 134.

Option Default Value Details

-webccserver

-w

-c
Inactive

Installs HarmonyWeb Control Center as a service.
This parameter is required if this machine is the
HarmonyWeb Control Center server.

2. Reboot after installing HarmonyWeb Control Center as a service. The service should run at every reboot.

How to install the Cisco OpenH264 library

1. In a shell, type the following:

cd /usr/local/ToonBoomAnimation/harmonyAdvanced_12.1/lnx86_64/bin./openh264_
control.sh

The following appears:

Running script for installing/uninstalling the Cisco OpenH264 library

OpenH264 Video Codec provided by Cisco Systems, Inc.

Do youwish to install (i) or uninstall (u) the library?

2. Type the following to install the library: i

3. Now you have a choice of the two following libraries. Try the first. If there are problems, try the second.

‣ openh264-linux64-v1.3.zip (0)

‣ libopenh264-1.3.0-linux64.so.bz2 (1) 0

TheOpenH264 library installation is successful.
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Configuring the Licensing

Setting Up in a Non-Gui Environment

How to install Harmony WebControl Center on a Linux server with no GUI

1. Contact Toon Boom Support to request a copy of the Flexnet Publisher anchor script (install_fnp.sh)
and the FlexNet Publisher Licensing Service (FNPLicensingService).

2. Place both files in the bin directory of your Harmony install. It is typically located here:

/usr/local/ToonBoomAnimation/harmony_12.1/lnx86_64/bin

3. Change the permissions on the anchor script to be executable:

chmod 755 install_fnp.sh

4. Execute the following script

./install_fnp.sh

5. Execute the following command to install the license:

ServerActivation -batch -served -comm soap -commServer
https://licensing.toonboom.com:443/flexnet/services/ActivationService
-entitlementID XXXX-XXXX-XXXX-XXXX-XXXX

6. Type the activation key next to -entitlementID to replace the Xs.

Managing the Harmony Web Control Center Service

If at any point, you need to start/stop or restart the HarmonyWeb Control Center server. You can do so
through the /sbin/service in Linux.

To start the service /sbin/service USAnimation_harmony_webcc start

To stop the service /sbin/service USAnimation_harmony_webcc stop

To restart the service /sbin/service USAnimation_harmony_webcc restart

Alternatively, you can start or stop all Harmony Services with the following commands:

To start all services
/usr/local/ToonBoomAnimation/harmony_12.1/lnx86_
64/bin/Startus

To stop all services
/usr/local/ToonBoomAnimation/harmony_12.1/lnx86_
64/bin/Stopus

Customizing the Harmony Web Control Center Service

You can customize some parameters, such as the default port, for the HarmonyWeb Control Center service.
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How to customize the Harmony WebControl Center Service

1. Stop the service if it is active—seeNetwork Setup on page 134.

2. As the root user, open the following file:

/usr/local/ToonBoomAnimation/harmony[edition]_[version]/lnx86_64/bin/webcc.sh

3. After the last character, add HarmonyWeb Control Center parameters after the last character.

#!/bin/sh -f

# Script to start Harmony Web Control Center server

DIRNAME=$(dirname "$0")

cd "$DIRNAME"

./bin_3rdParty/node ../../cloud/server/app.js "$@"

The customizable parameters are:

Parameter Description

-numWorkers n

Number of processes to service client requests. Default is number of CPU
cores. Set to 0 to disable worker child processes. If the number of CPUs is high,
performance could be impacted on all processes running on the server. If server
is mostly for Web Control Center, increase the number for better performance.

-noAuth
Disables basic login/authorization verifications with the user database. Default:
authorization enabled.

- port port The port to which HarmonyWeb Control Center is deployed. Default: 8080.

-http port
Enables http protocol on specified port (can be used along with https to enable
both). Default: http enabled unless -https is also enabled.

-exchange loc Location (on disk) of top-level file exchange folder. Default: /USA_DB/exchange

-cacheDuration s
Number of seconds to keep data in cache. Default 3600. 0-> disable cache, 1-
999999-> number of seconds to keep data in cache.

-allowAllOrigin
Enables webcc web service from all sources (enable cross-origin resource shar-
ing). Default: Disabled.

-disableAnalytics Disables Google Analytics tracking for all clients. Default: Enabled.

Options Related to SSL Server

-https [port]
Enables https protocol on port 8443, unless a port override is provided.
Default: Disabled.

-key key
<filename> the private key for the SSL session (works with -cert). Default:
None.

-cert cert
<filename> the certificate filename for the SSL session (works with -key).
Default: None.

-pfx file
<filename> alternate filename that includes both the private key and certificate
for the SSL session. Default: None.
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4. Save and close the file.

5. Start the service—seeNetwork Setup on page 134.

Running Harmony Web Control Center Manually

If you do not want to run HarmonyWeb Control Center as a service, you canmanually start the HarmonyWeb
Control Center server.

How tomanually run HarmonyWebControl Center

1. Using the Terminal, navigate to:

/usr/local/ToonBoomAnimation/harmony_12.1/lnx86_64/bin

2. Run the following:

./webcc.sh

NOTE: You can change the default port used by HarmonyWeb Control Center by modifying the webcc.sh. Open
the file using a text editor and add the value of the parameter and the desired value. See the following text:

#!/bin/sh -f
# Script to start Harmony Web Control Center serverDIRNAME=$(dirname "$0")
cd "$DIRNAME"
./bin_3rdParty/node ../../cloud/server/app.js "$@" -port 8081

Other parameters can be customized—see Customizing the Harmony Web Control Center Service .

Network Setup

Setting Up a Static IP

How to set up a static IP for RedHat, Fedora or CentOS

1. Edit the file /etc/sysconfig/network:

/etc/sysconfig/network

2. Configure the file as follows; replacing the bolded text with your values:

NETWORKING=yes

HOSTNAME=webcc.toonboom.com

3. Depending on your network card, open the configuration file. For example, if you are using eth0, then
you would edit the file /etc/sysconfig/network-scripts/ifcfg-eth0.

/etc/sysconfig/network-scripts/ifcfg-eth0

4. Configure the file as follows, replacing the bolded text with your values:

DEVICE=eth0
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BOOTPROTO=static

IPADDR=174.142.76.72

NETMASK=255.255.240.0

GATEWAY=10.120.0.254

ONBOOT=yes

5. Edit the following file:

/etc/resolv.conf

6. Configure the file as follows, replacing the bolded text with your values:

search toonboom.com

nameserver 10.120.0.1

7. Restart the network service:

/etc/init.d/network restart

Opening a Port for External Connection

It is necessary to open a port in your firewall to allow other computers to access your HarmonyWeb Control
Center server. HarmonyWeb Control Center is using port 8080 by default.

How to open a port for RedHat, Fedora or CentOS

1. Edit the following file:

/etc/sysconfig/iptables

2. Append the following rule to the file to open port 8080:

-A RH-Firewall-1-INPUT –m state –state NEW –m tcp –p tcp –dport 8080 –j
ACCEPT

3. Save and close the file.

4. Restart the iptables service:

service iptables restart

Web Browser Note

NOTE: Some browsers don't support Java and will have problems opening scenes. The first time you open a scene in
a browser, it might take a long time because it has to set Java.
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Chapter 4: Batch Processing
Harmony Server uses batch processing to convert scanned drawings to a vector-based format or to render the
final animation. The system performs these tasks in the background.

There are two types of batch processes in Harmony; both can run on almost any computer on the network:
vectorize and render.

Vectorize

The vectorizing process prepares the images scanned on a black and white scanner for painting by converting
them to vector based files (*.tvg files). This converts the drawings from a bitmap format to a digital line-based
format.

Vectorizing prepares images for painting by creating paint files. You would only have to manually send scenes to
be vectorized in special cases such as:

• Processing images that were not scanned in the Scanmodule

• Reprocessing a scene due to unrecoverable paint errors

• Completing the vectorization after you run the scene through a pencil test

You can open the VectorizeQueue in the Control Center module to view the list of vectorizing work waiting to be
processed.

Render

Also known as compositing, the rendering process composites scenes to create the final frames.

When you have finished working on a scene or all of your animated sequences, you can render it locally or send it
to the Render Queue. After you render the animation, you can transfer the scenes to video or film.

You can open the Render Queue in the Control Center module to view the list of compositing work waiting to be
processed.

Setting Up the Batch Processing

When you create a new environment for a project, youmust set up the batch processing. You can create a
particular batch processing schedule and assign certainmachines on your Harmony network to vectorize and
render the scenes in that environment.

Youmust set up batch processing on selected Harmonymachines to convert scanned drawings to vector files and
to composite final frames.

NOTE: It is not recommended to render or vectorize on the workstation while you are working in the software. These
tasks are resource intensive and will slow your computer down if you are work in the software at the same time. If
urgently needed on a continual basis, set up a separate render station. Otherwise, batch processing should be done
while the workstation is inactive.

With Harmony batch processing, you can spread the workload across multiple computers on the network,
creating a render farm. To do this, youmust identify all the computers that will be processing Harmony files and
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start the batch processing queues. Then, you set up all the environments to add to the database for batch
processing.

Once this is done, you can send drawings to be vectorized and scenes to be rendered.

NOTE: To view thumbnails and move preview, you must install the Cisco OpenH264 library—see Installing
Harmony Server on page 9.

This chapter is divided as follows:

• Installing Batch Processing and Configuring themachine-list File on page 138

• Creating themachine-list File (Linux) on page 145

• The tbprocess Program on page 146

• Setting Up Default Schedules on page 152

• Testing Batch Processing on page 154

• Troubleshooting on page 162

• Advanced Batch Processing on page 165

• Vectorizing Scenes or Elements on page 155

• Rendering Scenes on page 157

• Stopping a Process on page 160

Installing Batch Processing and Configuring the machine-list File
The machine-list file identifies all themachines on your network that can be allowed to batch process
Harmony files. Themachines on this list represent the render farm.

NOTE: You must have sufficient batch processing licenses to run batch processing on all the machines in the
machine-list file.

IMPORTANT: Make sure the H264 codec is installed on all the machines that will do the batch render of movie
previews—see Installing Harmony Server on page 9.

Windows

InWindows, use the Harmony ConfigurationWizard to add computers to the machine-list file and to
install the batch processing service. Youmust run the ConfigurationWizard on all machines that will perform
batch processing.
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How to configure batch processing

1. In the Harmony ConfigurationWizard, click Batch Processing.

2. In the Batch Processing screen, select the Yes option to have your computer perform batch processing.
Click Next.

3. In theWhat is the Name of the Server field, enter the name of the Harmony server.

4. In theWhat is the User field, enter the server's user name (OS account) created while setting up the Har-
mony database. Themachine you are setting up will use this user name and password to log on the server
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machine and retrieve the data to render or vectorize.

5. In theWhat is the Password field, type the password corresponding to the selected user name.

6. Click Next.

The Harmony ConfigurationWizard presents a review of all the changes that will bemade.

7. Click Finish.

Mac OS X

OnMacOS X, use the Configuration Assistant to install the batch processing queue Startup Item that will start
the batch processing service. Youmust run the Configuration Assistant on all machines that will perform batch
processing.

How to install the batch processing queue Startup Item

1. In the Finder, go to Applications > Toon Boom Harmony 12.1 [edition] > Tools > Configuration
Assistant.

2. Select theCreate the Startup Items option and click Continue.
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3. Select theCreate Harmony WebControl Center Server Startup Item option and click Create.
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The Authenticate dialog box appears asking for a user name and a password.

4. Type a user namewho is allowed to administer the computer and click OK.

The necessary files to automatically start the batch processing queue on the counter are copied.

5. Repeat these steps on all the computers that will be performing batch processing.

The files required to start the batch processing queue are copied by the Configuration Assistant in:

/Library/StartupItems/ToonBoomQueueServer/ folder.

A dialog box appears to indicate if the Startup Itemwas successfully created.
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6. Click OK.

The Finish window appears.

7. Click Done to close the Configuration Assistant.

Machine-list File

Themachine-list file identifies all themachines on your network that are allowed to batch process Harmony files.
Themachines in this list represent the render farm. Youmust have sufficient batch processing licenses to run
batch processing on all of themachines in themachine-list file.
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How to create the machine-list file

1. In a text editor, create a new text file.

2. In the new text file, enter all themachine names in your render farm.

The order that you list machine names determines their order in the batch processing scheduling
commands.

IMPORTANT: There must be no blank lines in the machine-list file.

For example, your machine-list might look like this:

anim-1

anim-2

anim-3

bart-1

bart-2

paint-1

paint-2

paint-3

‣ Your machine name is created when you install MacOS X. You can list themachine name of a
computer by typing the following command in the Terminal or command prompt:

hostname

3. Save the file with the namemachine-list in the /USA_DB/schedules/ directory.

Adding the Web Render Script to Harmony

In the Script Editor, you should have a TB_WebCC_render.js script, which is installed when you create the web
server. For previous versions of the Harmony database, it must be addedmanually.

How to add the TB_WebCC_render.js script

1. From the Script Editor view menu, select File > Import Script.

2. Select the TB_WebCC_render.js script from one of these locations:

l Windows: Program Files (x86)> Toon BoomAnimation > Harmony 12.1 [edition] > resources > scripts

l MacOS X: Applications > Harmony 12.1 [edition] > tba > resources > scripts

l Linux: /usr/local/ToonBoomAnimation/harmony_12.1/resources/scripts
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l Linux: /usr/local/ToonBoomAnimation/harmonyAdvanced_12.1/resources/scripts

2. Click Open.

The Save Script window opens.

3. Choose a location in which to save the script. We suggest Global so the script is available for any user,
environment or job.

4. In the Script Manager dialog, in the File column, select the TB_WebCC_render.js script.

Copying the comp.dict File

If you keep the database that was created with an older version of Harmony, note the comp.dict file is not
updated automatically when you install the latest version. Youmust manually replace the file with the latest
version by taking the file from your local installation.

How to copy the comp.dict

1. Copy the comp.dict file from your local installation of Harmony:

‣ Windows: Program Files (x86)\Toon BoomAnimation\Toon BoomHarmony 12.1 [edition]
\etc\USADB_templates\dicts

‣ MacOS X: Applications/Toon BoomHarmony 12.1 [edition]/tba /etc/USADB_templates/dicts

‣ Linux: /usr/local/ToonBoomAnimation/harmony_12.1/etc/USADB_templates/dicts

2. Paste the file in usa_db >dicts folder, replacing the old comp.dict file.

Creating the machine-list File (Linux)
The machine-list file identifies all themachines on your network that are designated for batch processing
Harmony files. Themachines on this list represent the render farm.

NOTE: You must have sufficient batch processing licenses to run batch processing on all the machines in the
machine-list file.

How to create the machine-list file on Linux

1. Using a text editor, create a new text file. Enter all the names of themachines in your render farm. The
order in which themachine names appear determines their order in the batch processing scheduling com-
mands.
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IMPORTANT: There must be no blank lines in the machine-list file.

For example, your machine-list might look like this:

anim-1

anim-2

anim-3

bart-1

bart-2

paint-1

paint-2

paint-3

Themachine name is created when you install Linux. List themachine name of a computer by entering
the following in a terminal or command prompt:

uname -n

2. Save the file as machine-list in the /USA_DB/schedules/ directory.

The tbprocess Program
The tbprocess programmonitors the database queues for batch processing work to be done. When it finds a
batch processing job to complete, it launches the appropriate Vectorize or Render programs to process the
job (you canmonitor these jobs using the queues in the Control Center module. In order for a machine to
perform the batch processing, youmust launch the tbprocess program on it.

You can use a set of schedules to better manage the batch processing on your Harmony system. While
scheduling dictates the type and time a machine will perform batch processing, the tbprocess program does
the actual batch processing work (for both vectorize and render batch processing).

There are several ways to start the tbprocess program on a machine and then verify that it is running. You can
run only one session of tbprocess per machine. If you try to runmore than one tbprocess session, nothing
happens (the first session keeps running). By opening the log file, you canmonitor the jobs taking place in the
tbprocess session.

NOTE: Remember that just because tbprocess is running on a machine, it does not mean that the machine is
actually doing any batch processing work at that moment. The schedules determine the location and time when
the machines perform batch processing work.

This section is divided as follows:

• Starting the Batch Processing Queue onWindows on page 147

• Starting the Batch Processing Queue on Linux on page 148

• Starting the Batch Processing Queue onMacOS X on page 148
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• Verifying that a tbprocess Session is Active on page 150

• Monitoring a tbprocess Session on page 151

Starting the Batch Processing Queue on Windows

When you launch a Harmonymodule, some functions are performed in the background that you generally do not
see. Two of these functions are as follows:

• tbprocess: Manages requests for batch processing of vectorized drawings or rendered scenes.

When you ran the Harmony ConfigurationWizard, you had the option of having batch processing on your
system. If you selected the Yes option and had a valid license, the tbprocess starter is ready to run;
otherwise, you cannot perform batch processing on Harmony.

• tbdbserver: When you have a Server/Standalone configuration, this function controls the entries youmake
to the Harmony database (like adding new scenes to a job).

NOTE:When you run the Toon Boom Harmony Configuration Wizard, it automatically configures your system to
launch the tbdbserver, so you do not need to configure anything else.

How tomodify the Process Starter launch properties

1. From the Start menu, select All Programs > Toon Boom Harmony [version] > Tools > Control Panel.

The Toon BoomHarmony Control Panel dialog box opens.

2. Select the Process Starters tab and select a specific process starter to view its parameters.

The Process Starters tab displays the following information:

‣ User: Displays the profile that the process starter uses by default.

‣ Password: Displays the password for the user specified in the User field.

‣ Command Line: Displays the path of the application you want the process starter to launch.

‣ Log File: Displays the name of the log file that records all themessages from the application specified
in the Command Line field.
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‣ WorkingDirectory: Displays the path that contains all the applications you need and where these
applications can store data while they run.

3. Make anymodifications you need to the existing services and click Update parameters.

4. Click OK.

Starting the Batch Processing Queue on Mac OS X

After themachine-list file has been created and the Startup Item has been installed, you are ready to start the
batch processing queue. The Startup Itemwill start the batch processing queue automatically every time the
computer is started, but you can start it without restarting the computer.

NOTE: Note that the user must have administrator privileges on the computer.

How to start batch processing queues

1. Open theMacOS X Terminal application.

2. Go to Applications > Utilities > and double-click on the Terminal.

3. Type the following in the Terminal:

sudo /sbin/SystemStarter start ToonBoomQueueServer

The Terminal prompts you for your password.

How to stop batch processing queues

‣ Type the following in the Terminal:

sudo /sbin/SystemStarter stop ToonBoomQueueServer

The Terminal prompts you for your password.

Starting the Batch Processing Queue on Linux

After themachine-list file is created, you are ready to start the batch processing queues. Theymust be started
on all machines that will perform batch processing.

How to start the batch processing queues

‣ Type the following in the Terminal or command prompt:

/sbin/service USAnimation_queues start

Amessage appears in the shell indicating that the script was successful.

The tbprocess program is installed with the Toon BoomHarmony system. It monitors the Vectorize and
Render batch processing queues for work to be done and runs the appropriate programs to vectorize or
render the images.
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If you reboot themachine after installing the Toon BoomHarmony, the tbprocess program starts automatically
on each Toon BoomHarmony client and server.

NOTE:
During a normal installation, Harmony places a file called S98USAnimation_queues in the /etc/rc2.d/ folder. This
file controls the launching of the tbprocess program when you reboot.

This file name S98USAnimation_queues may change and the first two numbers at the beginning of the file name
could be:
S97USAnimation_queues,S96USAnimation_queues, S95USAnimation_queues and so on.

If you do not see this file in the /etc/rc2.d/ folder, you need to reinstall the links for Harmony. However, if you do
not reboot after you install the Toon Boom Harmony system, or someone stops the tbprocess program on a specific
machine, you must start the tbprocess program on each machine assigned to the batch processing schedule before
you can batch process the items in the Vectorize or Render queues.

How to launch the tbprocess program on a batch processingmachine

1. Open a command prompt and log in as the root user on themachine onwhich you want to start the Pro-
cess program.

2. Type the following:

/etc/init.d/USAnimation_queues stop

3. Press Return to make sure there are no tbprocess programs already running.

Type /etc/init.d/USAnimation_queues start

4. Press Return.

A PID (Process ID) number appears when the tbpprocess starts.

[1] 19003

To stop the Process program on a machine, type /etc/init.d/USAnimation_queues stop and
press Return.

5. To view the batch processing schedule status for all machines, type Status and press Return.

The batch processing schedule appears.
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The column on the left displays an R for eachmachine onwhich you launched the tbprocess program.

Verifying that a tbprocess Session is Active

There are two commands you can use to verify that tbprocess is running on a machine. To use a command,
type it in a Command Shell or Terminal and press Enter/Return.

• Status command

This command allows you to view the Schedule Status—seeDisplaying the Schedule Status on page 166.
If tbprocess is running on a machine, an R appears in the R column for that machine.

Windows

OnWindows, the process can be verified from:

• Toon Boom Harmony Control Panel: Control Panel > Toon BoomHarmony Control Panel

• Services panel: Control Panel > Administrative Tools > Services panel

Mac OS X

• ps -axc | grep roc command

150



Harmony 12.1 Server Installation Guide

This command verifies if you have a tbprocess session running on a machine.

• -a displays information about other users' processes as well as your own.

• -x displays information about processes without controlling terminals.

• -c changes the "command" column output to contain just the executable name, rather than the full
command line.

A list of all the processes running appears:

The ps command is a Linux statement used to report active processes. There are a variety of options and
arguments that you can run with this command to limit or alter the information that appears. The arguments used
with the ps command in this document are only suggestions. Refer to your Linux manuals for more information
on the different options and arguments available with the ps command.

Linux

• ps –f –u usabatch | grep roc command

This command verifies if you have a tbprocess session running on a machine.

• –f produces a fully-detailed list of information.

• –u usabatch lists only information by the user usabatch.

Sincemore than one user can start the tbprocess program, you can view a more complete list by removing
the -u usabatch parameter from the command. You can also replace this parameter by –efa to view all
the processes on themachine, regardless of the user (except the processes that are not linked to an
Command shell).

• | grep roc searches for commands that contain the letters “roc”. This allows you to filter the
output.

A list of all the processes running for usabatch appears:

Monitoring a tbprocess Session

As the tbprocess program batch processes jobs, you can see which one are being processed and which ones are
waiting in the queue. This is handy in case you want to remove old jobs from the queue because youmade
changes to them, or if you want to change the processing priority in the jobs.

There are two ways to monitor the tbprocess session:

• Using theQueuewindows in the Control Center module.

The easiest way to monitor a tbprocess session on a particular machine is to open the Vectorize or Render
queues using the Control Center module.

• Typing the ssh and tail commands in a Linux shell.
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When checking a machine's Vectorize or Camera queues, remember that if themachine is scheduled to
perform processing work for multiple environments, youmay need to search both queues in several of the
environments to get a complete picture of what is happening.

Viewing Specific Events in the tbprocess Session

Windows: If you want to check the log on theWindows machines in your network, youmust access the
machines themselves and view the tbprocess.log file in a text editor. Some text editors require that you
stop the tbprocess session before you open the log file because it locks the file while recording.

MacOS X: As the Process session vectorizes jobs, it stores them in a log file. You can find the log files in
/Library/Logs/ToonBoomQueueServer.log file.

Linux: As the Process session vectorizes jobs, it stores them in a log file. You can find the log files in
/tmp/tbprocess.log file.

Viewing tbprocess Events on One Machine (Linux and Mac OS X)

If you want to view the tbprocess jobs for a specific machine, you can remotely log in to that machine view the
entries in the tbprocess.log file as they get added.

You need to use the two following commands to view these entries:

• ssh: Allows you to connect remotely to another machine and launch a specified command. The remote
connection stays open for the duration of the command and then closes, ending the connection.

• tail: Displays the latest 10 lines of the specified file as they appear.

To view the entries in the tbprocess.log file as they occur, open a shell or Terminal and type:

Linux:

ssh machine tail -n -10 -f /tmp/tbprocess.log

MacOS X:

ssh machine tail -n -10 -f /Library/Logs/ToonBoomQueueServer.log

• machine is the name of themachine running the tbprocess you want to monitor.

• -n 10 instructs the tail command to display the latest line of the file (you can change this value if you
want).

• -f instructs the tail command to update the display as the file changes.

When using the tail command with the -f option, youmust use [Ctrl] + [C] to quit the command.

Setting Up Default Schedules
When you first set up your Harmony system, it is a good idea to set up a default batch processing schedule.
You canmodify this schedule later based on the operating needs of your studio.

If you have not created any environments, there will not be any environments for you to start up.

Youmust start up a default schedule for every environment you create in the Harmony database.
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NOTE: Maintaining a limited number of environments will make it easier to set up and manage batch processing
queues. For example, you can create four environments, like test, commercials, and one environment per features
or series.

How to define the default batch processing schedule

1. Open a command prompt or Terminal and type:

Setdef

Follow the onscreen instructions to set up the environment for batch processing by selected machines on
the Harmony network.

2. Enter themachine name onwhich you want to set up batch processing:

INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all

‣ Type all  to create a default schedule for all machines in themachine-list or press Enter/Return to
create a schedule only for themachine you are currently using.

3. If you enter only onemachine name, decide if you want to addmoremachines to process this environment.

DO YOU WANT TO INPUT MORE MACHINES

‣ Type y and press Enter/Return if you want to enter moremachines or press Enter/Return if you do not
want to enter anymoremachines.

4. Identify the type of work this machine will be doing: vectorizing, rendering or both.

INPUT TYPE OF WORK ALLOWED is vectorize work allowed

‣ Type y if this machine will vectorize drawings.

is camera work allowed

‣ Type y if this machine will render scenes.

‣ Identify the environments this machine will process.

INPUT A SET OF DATABASE Environments

‣ Type the number (not the name) for each environment you want to set up on this machine and press
Enter/Return. A space (or a comma) must separate each environment number.

should processing of the dbenv's be prioritized

5. You can prioritize the environments based on the order you entered them in the previous step. Typically,
you will not want to prioritize environments like this.

‣ Type n and press Enter/Return if you do not want to prioritize environments.

6. Turn the input on for themachine

input ON or OFF

‣ Press Enter/Return to turn the input on.
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When you are done, a status message appears indicating that themachine is set up for batch
processing using the default schedule.

7. To view the batch processing schedule status for all machines, type the following:

Status

8. Press Enter/Return twice to get the report.

Themachines that are set up to batch process should appear in the report. Theremust be an R next to
themachine name and the status must beOn to be able to batch process.

Testing Batch Processing
To verify that batch processing is working, send a few frames from a scene to be rendered by the Stage
module.

How to test batch processing

1. Open the Control Center and select the environment and job that contains the scene to render.

2. Select the scene, right-click on the sample scene in the Scenes section panel and select Send to Ren-
dering.

The Render Network dialog box opens.

154



Harmony 12.1 Server Installation Guide

3. In the Range section, select the Selected Frames option and type 1 to 5 in the From and To fields. Leave
the rest of the default options and click OK.

Anmessage appears indicating that the scene was sent to the queue.

4. Click OK to close themessage .

5. Open the Render Queue to see if your scene is being processed.

6. In the Environments section, select the environment with the scene that is rendering.

7. Select Environment > Render Queue.

The Render Queuewindow opens. You should see the sample scene listed. Its state will change from
"Pending" to "Processing" and then to "Completed" after it has been rendered.

Vectorizing Scenes or Elements
Before you can paint a scanned drawing in Harmony, youmust convert it to a vectorized image format. The
vectorizing process converts the drawings from a bitmap format to a vector line-based format.

Normally, when you scan drawings, Harmony automatically vectorizes them (sends them to the Vectorize queue).
However, you can also use the Send to Vectorize command to reprocess all drawings for a particular element.
Vectorizing prepares images for painting by creating vector files. You would only have to manually send scenes to
be vectorized in special cases such as:

• Processing images that were not scanned with the Scanmodule

• Reprocessing a scene due to unrecoverable paint errors

The Vectorize queue displays all the drawings that the system is converting to a vector-based format. After the
vectorization of a drawing is finished, the completed drawing disappears from the Vectorize queue.

How tomanually vectorize all the drawings for a scene or an element

1. Select a scene from the Scenes list or an element from the Elements list.
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If you selected a scene, Harmony vectorizes all drawings for all elements of that scene.

If you selected an element, Harmony vectorizes all its drawings.

2. Depending on the component you selected, do one of the following:

‣ Select Scene > Send to Vectorize or right-click and select Send to Vectorize.

‣ Select Element > Send to Vectorize or right-click and select Send to Vectorize.

The Confirm dialog box appears.

3. Click Yes to vectorize all the selected drawings.

The Control Center module sends all drawings in the scene or element to the Vectorize queue. To verify
how the processing is progressing, display the vectorize queue.

How to view the list of drawings being vectorized

1. Select an environment name from the list, then select Environment > Vectorize Queue.

The VectorizeQueuewindow appears.

2. From the Sort Bymenu, select how to sort entries in the queue:

‣ State: Sorts the entries based on the item's status (Pending, Pending-E, Processing, or Completed)

‣ Entry time: Sorts the entries based on the time you send them for vectorization.

‣ Job, Scene, etc.: Sorts the entries based on their parent jobs and scenes.

‣ JobID: Sorts the entries based on their unique job ID.

3. If the Vectorize queue has too many entries, you can select a specific job, scene, element, or drawing
that is in the queue. Select the items you want to display in the queue from the Show menu, which dis-
plays all items in the Control Center node's database, not just the ones that have drawings being vec-
torized.

‣ Jobs: Selects the specific job in the queue or one that has scenes currently being vectorized. To see
all the jobs, select All Jobs.

‣ Scenes: Selects the specific scene that is in the queue or currently being vectorized. To see all the
scenes in a job, select All Scenes.
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4. Select the states you want to display in the queue from the Show States options:

‣ Pending: Displays the items waiting to be vectorized.

‣ Error: Displays the items where the system found an error and has stopped vectorizing them (displays
Pending-E as the item's state).

‣ Processing: Displays the items that the Harmony is currently processing.

‣ Completed: Displays the items that were vectorized. However, the Control Center node usually
removes completed items from the Vectorize queue, so this option is inactive.

‣ Show All States: Displays all the items, regardless of their state.

5. In the Refresh section, select how often you want the queue to check for the latest entries.

‣ Hold: Displays no new entries to the queue once the button is activated.

‣ Monitor: Automatically displays new entries at the interval you enter in the Every ## secs field.

6. To see any related errors for each entry in the queue, select the Show Error Messages option.

If the Control Center node detected any errors while it prepares the drawings, it displays Pending-E in the
State column. These errors can occur if there are files missing, computers are unavailable, or data cannot
be found.

NOTE: Most of these errors would occur if the system is improperly configured. Therefore, your system administrator
needs to reconfigure the system to correct the error. If you get a Pending-E error, see your system administrator.

Modifying Entries in the Vectorize Queue

When you have a list of entries in your queue, you canmodify them in one of the following ways:

• Click theChange State to Pending button to change the status of the selected entries in the queue from
Processing to Pending. After a job becomes Pending, the next availablemachine will process the entry.

If you want to remove the entry from the queue, select the Pending entry and click Delete. If the entry is
processing, you can delete the entry from the queue but the processing will not stop until it is completed.

You can onlymodify an entry in the queue while it is pending (check the State column in the queue list). You
cannot modify a job that is being processed.

• Click theChange Priority button to change the selected drawings' processing priority in the queue. When
theNew Priority dialog box appears, increase or decrease the drawing's priority.

• Click theDelete button to delete the selected drawings from the queue. When you remove a drawing
from the queue, the request is cancelled only.

Rendering Scenes
When you have finished working on a scene or all of your animated sequence, you can send them to the Render
queue via Control Center or Stage. After you render your animation, you can transfer the scenes to video or film.

After rendering a scene, you canmark it as completed using the Change Stage command in the Scenemenu. After
you render all the scenes for a particular Job, you canmark the Job as completed using the Change Stage
command in the Jobmenu.
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NOTE: Changing the job's stage from In Production to Completed only hides the job in the Control Center window.

Viewing the Render Queue

The Render queue displays all the scenes from the selected environment that the system is rendering. After the
system renders a scene, the State of the rendered scene changes to Complete or Completed with Errors and
the scene remains in the queue. If you want to remove the rendered scenes, youmust select them and use the
Delete button.

How to view the scenes being rendered

1. Select an environment name from the list, then select Environment > Render Queue.

The Render Queuewindow appears.

2. Select how to sort the entries in the queue from the Sort By.

‣ State: Sorts the entries based on the item's status (Pending, Pending-E, Processing, Completed
with Errors, or Completed).

‣ Entry Time: Sorts the entries based on the time you sent them for rendering.

‣ Job, Scene, etc.: Sorts the entries based on their parent jobs and scenes.

‣ JobID: Sorts the entries based on their unique job id.

3. Select the components you want to display in the queue from the Show.

‣ Jobs: Select the specific job you want to see.

‣ Scenes: Select the specific scene you want to see.

4. Select the states you want to display in the queue from the Show States options.
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‣ Pending: Displays the items waiting in the queue.

‣ Processing: Displays the items that currently processing.

‣ Completed: Displays completed items.

‣ Error: Displays the items that contains errors that stopped processing (displays Pending-E as the
item's state).

‣ Show All States: Displays all items, regardless of their state.

5. In the Refresh section, select how often you want the queue to check for the latest entries.

‣ Hold: Displays no new entries to the queue once the button is activated.

‣ Monitor: Automatically displays new entries at the interval you enter in the Every ## secs field.

6. Select the Show Error Messages option to see any related errors for each entry in the queue.

NOTE:
If the Control Center node detects any errors while processing the scenes, it displays "Pending-E" in the State
column. Errors can occur if there are files missing, computers are unavailable, or data cannot be found.

Many of these errors can occur if the system is improperly configured. If you get a Pending-E error, see your system
administrator as the system may need to be reconfigured.

Modifying the Entries in the Render Queue

After you have a list of entries in your queue, you canmodify them in one of the following ways:

1. Change their state in the queue. This allows you to update the status of a scene, or set of scenes, in the
queue from Processing (whichmeans it is being rendered) to Pending (whichmeans the scenes are waiting
to be rendered). After you set a job to Pending, the job remains in the queue until a machine becomes avail-
able and takes the job or you delete it from the queue.

‣ Click theChange State to Pending button to change the status of the selected entries in the queue
from Processing (or Completed) to Pending.

2. Change the scene's processing priority. This allows you to change the order in which the system renders
the scenes.

‣ Click Change Priority to change the selected scene's processing priority in the queue.

‣ When theNew Priority dialog box appears, use the scroll bar to increase or decrease the scene's
render priority.

3. Remove scenes from the Render queue. This allows you to cancel the render command on selected scenes.

‣ Click theDelete button to delete the selected entries from the queue.

You can onlymodify an entry in the render queue while it is pending (check the State column in the queue list); you
cannot modify a job that is being rendered.

If youmust change something about the scene's drawings, youmust wait until the rendering is complete. Then
make your changes and send it to the Render queue.
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NOTE: If you absolutely must stop the rendering process, you can kill the render process in Windows, Linux or Mac
OS X.

Stopping a Process

IMPORTANT:
DO NOT STOP THE PROCESS UNLESS ABSOLUTELY NECESSARY.
An example of an extreme case is if you sent 10,000 drawings for vectorization and only one machine is available to
handle the job (which means it will take hours to complete).

DO NOT ATTEMPT TO STOP THESE PROCESSES YOURSELF. If you must stop a process, see your system
administrator.

After you send a scene's drawing for vectorization or rendering, you can remove it from the queue easily. If the
process is pending in Vectorize or Render queue (check the State column in the queue list), you can simply
remove it by selecting the job and clicking theDelete button in the Vectorize/Render Queuewindow.

But once the vectorizing or rendering process actually begins, it gets a bit more complicated to stop the
process. If you really must stop a vectoring or rendering job, youmust remove it from the Vectorize or Render
queues and then find the actual process in your Windows Task Manager, MacOS XActivityMonitor or Linux
Shell and kill each task manually.

Stopping a Windows Process

IMPORTANT: DO NOT ATTEMPT TO STOP THESE PROCESSES YOURSELF. If you must stop a process, see your
system administrator.

How to stop a vectorize or render process on a computer runningWindows

1. In the Vectorize/Render Queuewindow, select the job you want to stop and click Delete.

2. Right-click on theWindows task bar and select TaskManager.

The Task Manager dialog box appears.

3. Select the Processes tab.
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4. Vectorizing or rendering starts a process named AnimatePro.exe. Locate it and select it.

5. Click End Process.

TheTask Manager stops the process and removes it from the Processes tab.

NOTE: If you stop a process, but do not delete the job from the Vectorize or Render queue, the queue marks the
entry as in error (Pending-E) and the entry stays in the queue. This is why it is important to remove the entry from the
queue before you stop the process.

Stopping a Linux Process

IMPORTANT: DO NOT ATTEMPT TO STOP THESE PROCESSES YOURSELF. If you must stop a process, see your
system administrator.

How to stop a vectorize or render process in Linux

1. Select the job to stop from the Vectorize/Render Queuewindow and click Delete.

2. As the root user, open a Linux shell and type:

ps -fe.

The shell window displays all the processes that are active at themoment.
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3. Find the listing for the vectorizing or rendering process that you started. There are two ID flags to look
for:

‣ If you started a vectorizing process, look for the process that lists the word Pix2vec -file
fileLocation.

‣ If you started a rendering process, look for the process that lists the word Stage -job jobName
-scene sceneName -version versionNumber.

4. Take note of the system number that identifies the process. In the example above, the system numbers
appear in the box on the left.

5. Type the following command and replace <id number> with the system number you noted in the pre-
vious step:

kill -9 <id number>

For example, if your process number is 5348 or 5353 (as in the example above), you would type the
following command to stop the process:

‣ kill -9 5353: Stops the vectorize process.

‣ kill -9 5348: Stops the rendering process.

6. Press Enter/Return.

NOTE: If you stop a process, but do not delete the job from the Vectorize or Render queue, the queue marks the
entry as in error (Pending-E) and the entry stays in the queue. This is why it is important to remove the entry from
the queue before you stop the process.

Troubleshooting
If you have any problems running Harmony after installation, review the installation and configuration
instructions to make sure you have followed them completely. If you continue to have problems, consult the
following list to troubleshoot common installation and configuration problems.
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• Problem: No Batch Vectorization or Rendering (Windows) on page 163

• Problem: No Batch Vectorization or Rendering (MacOS X) on page 164

• Problem: No Batch Vectorization or Rendering (Linux) on page 164

Problem: No Batch Vectorization or Rendering (Windows)

If drawings are not being vectorized or rendered you should check the status of batch processing machines.

How to check the status of the batch processingmachines

1. From the Start menu, select All Programs > Accessories > Command Prompt.

2. In the command prompt window, type Status and press Enter twice.

Themachines that are set up to batch process appear in the report. There should be an "R" next to the
machine name and the status must be "On" to be able to batch process.

‣ If machines aremissing from the report, run theHarmony Configuration Wizard to set up batch
processing on eachmachine that will vectorize drawings or render scenes—see Installing Batch
Processing and Configuring themachine-list File on page 138

‣ If a machine is in the report, but is set to "Off", youmust define a default schedule for themachine—
see Setting Up Default Schedules on page 152

‣ If a machine is in the report, but is missing the "R", restart the batch processing queues.

How to restart the batch processing queues

1. From the Start menu, select Control Panel from the Settings sub-menu.

The Control Panel window appears.

2. Double-click on the Toon BoomHarmony Control Panel icon in the Control Panel window.

The Toon BoomHarmony Control Panel dialog box appears.

3. From the Process Starter menu, select tbprocess-schedule.

4. Click Start restart the service. If the Start button is disabled, click Stop first, wait a couple of seconds, and
then click Start.

If you continue to have problems with batch processing, locate the tbprocess.log file and send it to
support@toonboom.com. This file is usually in: \Program Files\Toon Boom
Animation\Harmony\nt
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Problem: No Batch Vectorization or Rendering (Mac OS X)

If drawings are not being vectorized or rendered you should check the setup and configuration of batch
processing.

How to check the status of the batch processingmachines

1. In the Terminal, type Status and press Enter/Return twice.

Themachines that are set up to batch process appear in the report. There should be an "R" next to the
machine name and the status must be "On" to be able to batch process.

‣ If no machines appear in the list, make sure the /USA_DB/schedules/machine-list file lists all
of the computers that will do batch vectorization or rendering. Try resending elements to the
Render queue.

‣ If your machine appears in the list, but that there is no "R" next to it, the tbprocess servicemay not
be running. Verify that the tbprocess is active—see Verifying that a tbprocess Session is Active on
page 150.

‣ If there is no tbprocess session active, perhaps the processes were not installed when you installed
configured your installation. Verify that the ToonBoomQueueServer folder exists in the
/Library/StartupItems folder. If it does not, see The tbprocess Program on page 146.

‣ If the folder exists, start the tbprocess session by typing
sudo /sbin/SystemStarter start ToonBoomQueueServer
The Terminal prompts you to type your password. Your user needs to be allowed to administer this
computerin order for this command to work.

Problem: No Batch Vectorization or Rendering (Linux)

If drawings are not being vectorized or rendered you should check the setup and configuration of batch
processing.

How to check the status of the batch processingmachines

1. In a shell, type Status and press Enter/Return twice.

Themachines that are set up to batch process appear in the report. There should be an "R" next to the
machine name and the status must be "On" to be able to batch process.

‣ If no machines appear in the list, make sure the
/USA_DB/schedules/machine-list file lists all the computers that will perform batch
vectorization or rendering. Try resending elements to the Render queue.

‣ If you still have problems vectorizing and rendering, perhaps the processes were not installed when
you installed Harmony. Reinstall Harmony running the -p option. In a shell, change to the directory
where the installation script is stored and type:

./install -p

‣ Make sure that the queues are started. Type the following:

/sbin/service USAnimation_queues start
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NOTE: To learn more about the Linux installation process, refer to the Toon Boom HarmonyLinux Installation Guide.

Advanced Batch Processing
Once the basic vectorization and rendering batch processing is started, there aremore advanced options
possible such as advanced scheduling.

This section is divided as follows:

• About Batch Processing Schedules on page 165

• Setting Up Default Schedules on page 152

• Displaying the Schedule Status on page 166

• Using Default Schedules on page 168

• Using Periodic Schedules on page 173

• Using Supervisory Schedules on page 179

• Shutting Down and Starting Up Environments on page 184

• A Summary of Scheduling Commands on page 187

About Batch Processing Schedules

By creating a schedule to monitor the batch processing, you can determine whichmachines perform the batch
processing and when they do it. Each batch processing machine on your network has its own set of schedules and
you can view andmodify them from anymachine on the network.

There are three types of schedules available for a machine:

• Supervisory Schedule: Assigns a one-time batch processing job to a machine. For example, you can
define a Supervisory schedule for a machine to perform batch processing work for the next four hours.

Of the three types of schedules, Supervisory schedules have the highest priority. If you define a Supervisory
schedule for a specific period of time on a machine, it will perform the batch processing work according to
that schedule, regardless of what the Periodic and Default schedules define for that period of time.

• Periodic Schedule: Assigns recurring batch processing jobs. For example, you can define a Periodic
schedule for a machine to perform batch processing only on Saturdays and Sundays.

Periodic schedules use the days of the week, so you can have batch processing occurring each week on
specific days.

In terms of priority, a Periodic schedule supersedes a Default schedule, but not a Supervisory Schedule. If
there is a Periodic schedule active on a machine, then it performs this type of batch processing according
to its Periodic schedule before it uses the Default schedule.

• Default Schedule: Defines which jobs themachine can process if there are no other schedules defined.
Default schedules have the lowest priority, and are used only when Supervisory and Periodic schedules are
not present or do not define the work to be done for a particular period of time.

When creating or modifying a schedule, youmust supply the following information:

• Dates and times for which the schedule applies

• Machine(s) for which the schedule applies
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• Whether batch processing is ON or OFF (whether that machine does or does not perform batch
processing work)

• The type of batch processing to be done: Vectorize and/or Rendering

• The environments for which batch processing processes the artwork

• The priority of the environments to be batch processed (optional)

For any givenmachine, you can define, clear and view the Supervisory and Periodic schedules. You can only
modify or view the Default schedule for a machine.

You can also shut down and start up environments to stop and start batch processing of a particular
environment on a machine(s). When you shut down an environment, you are overriding whatever you already
scheduled for it (according to each type of schedule). Therefore, you will stop any batch processing jobs on the
environment until you start that environment again. You can also view a schedule's status to see an overview of
all schedules set for a specified time.

Displaying the Schedule Status

You canmonitor whichmachines are vectorizing or rendering animation data. The schedule status displays an
overview of what each render or vectorizemachine is processing at a specific time. The overview also displays a
machine's status based on the highest priority schedule set for the time you select.

You can display this status list by typing the Status command in a Command Shell or Terminal on anymachine
in the network. When you run the Status command, youmust specify the day and time for which you want to
view the schedule status.

How to display the schedule status list

1. Open a Command Shell or Terminal and type:

Status
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You can view the status for one or moremachines by listing them after the Status command (instead of
all themachines, which is the default). You can also type a prefix to search for machines with names that
start with the same prefix.

Example:

‣ Status hp: Shows the status for all machines that begin with "hp".

‣ Status cm hp6: Shows the status for all machines that begin with "cm" and for hp6.

‣ Status: Shows the status for all machines.

When you press Enter/Return, you are prompted to specify the time for which you want to view the
schedule status.

INPUT BEGIN TIME in 24-hr. format [15:17]:

2. Type the time youwant to view the status for in 24-hour format. If you press Enter/Return without spe-
cifying a time, the system uses the time displayed in brackets (the current time).

When you press Enter/Return, the system prompts you for the day for which you want to view the status.

input day [wed]:

3. Type the day of the week for which you want to view the status (you can not enter dates). If you press Enter-
/Return without entering a day, the system uses the day displayed in brackets (the current day).

The schedule status for the time and day you specified appears.

Reading the Schedule Status List

When you display the Schedule Status list, the information appears in three separate sections:

• Key: Lists the abbreviations the status schedule uses for the environments, the two types of batch
processes you can schedule on a machine, and the abbreviations the other columns use in the list.

• Schedule Status: Displays the processing status of each vectorizing or rendering machine in the network.

• Summary: Displays a summary of whichmachines are performing a specific type of batch processing
(vectorize or render). The summary appears directly below the Schedule Status section.

The following table describes the contents of the Schedule Status list:

Column title Description

R

Displays an R for eachmachine that has the tbprocess program running on it.
tbprocess must be running on a machine in order for that machine to perform
batch processing work.

For information on starting tbprocess:

Windows: See Starting the Batch Processing Queue onWindows on page 147

Linux: See Starting the Batch Processing Queue on Linux on page 148

If an R does not appear for a machine, the Schedule Status list displays what
would be scheduled if the tbprocess programwas running on it.

SD
Indicates if an environment is shut down for batch processing on that machine.
You can specify that certainmachines do not process environments by selecting
themachines that should be shut down (or turned off).
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An asterisk (*) appears in the SD column to indicate that one or more
environments have been shut down for that machine—see Shutting Down and
Starting Up Environments on page 184.

Machine
Displays the name of the networked machine that is configured to accept batch
processing jobs.

State

Indicates whether themachine is available for batch processing.

On: Themachine is scheduled to batch process.

Off: Themachine is not scheduled (for the time you specified) to batch process.

vec

status

Lists the type of batch processing themachine is scheduled to perform
(vectorize and/or batch processing ).

If an asterisk (*) appears in these columns for a machine, then this type of batch
processing is scheduled for this machine.

If a machine is scheduled to do both types of batch processing, themachine
performs both types alternatively; it processes an entry from the Vectorize
queue, vectorizes the data, and then take an entry from the Render queue.

Environments

Displays the environments scheduled to be batch processed on a machine.

Themachine batch processes only the data from the environments listed in this
column.

pri

Displays the priority level for batch processing on a machine. You can prioritize
environments so that onemachine can perform the batch processing before
another.

If an asterisk (*) appears in the pri column, the environments are prioritized for
that machine. The priority order for the environments appears in
the Environments column (reads from left to right, highest to lowest priority).

nexteventTime

Displays the date and time of the next status change for that machine,
according to the defined batch processing schedules.

For example, even though the hickeymachine is off at themoment, the Time
column indicates that the next time its status will change is at 12:53 on
Wednesday, March 8. This indicates that a Periodic or Supervisory schedule is
set for this machine.

Using Default Schedules

ADefault schedule sets batch processing for a machine when no other schedules are in effect. For example, if
there are no Supervisory or Periodic schedules that affect a particular machine onMonday at 9:00 a.m., the
Default schedule determines the type of batch processing that this machine performs at that time.

Every Harmony systemmachine uses a Default schedule to determine when it should perform batch
processing. You can display or modify the Default schedules for anymachine in the Harmony system.

This section is divided as follows:

• Displaying Default Schedules on page 169

• Modifying Default Schedules on page 171
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Displaying Default Schedules

When you display a Default schedule, you can see all the batch processing machines on the network and when
they are scheduled to perform batch processing work. The Default schedule also displays the type of batch
processing work (vectorize or render) and which environments are scheduled for the processing work.

After you display the Default schedule, you canmodify it to change the time, type of batch processing, or
environments to process—seeModifying Default Schedules on page 171.

How to display the Default schedule

1. In a Linux shell, type:

Showdef

You are prompted for themachine(s) whose Default schedule you want to see.
INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all [all]:

2. Select themachines you want to view by typing the name of a singlemachine, a prefix (to select a range of
machines that start with the same prefix), or all to view all the Default schedules for all themachines.

If you press Enter/Return without specifying a machine, the command uses themachine name that appears
in brackets.

NOTE:
If you type a prefix, a list of machines that contain that prefix appears. Type the numbers that correspond to the
machines you want to view.

For example, if you have three machines that start with "hi", you can type hi as a prefix. The system would then
display a list of all the machines that start with"hi":

input a set of machines, or hit return to indicate all these machines:

1 = hickey, 2 = highlander, 3=high-definition

You can press Enter/Return to select all the machines in the list or select specific machines by typing their
corresponding numbers.

You are asked if you want to view moremachines.

DO YOU WANT TO INPUT MORE MACHINES (y/n) [n]:

3. Decide if you want to view more environments and machines.

‣ Type y to select moremachines.

‣ Type n to not select anymoremachines.

The Default schedule for the selected machines appears.
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Reading the Default Schedule Status List

When you display the Default schedule status list, the system displays the information in two sections:

• Key: Lists the abbreviations the status schedule uses for the environments, the two types of batch
processes you can schedule on a machine, and the abbreviations the other columns use in the list.

• Schedule Status: Displays the processing status of each vectorizing or rendering machine in the
network

The following table describes the contents of the Schedule Status list:

Column Title Description

Machine
Displays the name of the networked machine that is configured to accept
batch processing jobs.

Status

Indicates whether themachine is available for batch processing.

On: Themachine is scheduled to batch process.

Off: Themachine is not scheduled (for the time you specified) to batch
process.

vec

ren

Lists the type of batch processing themachine is scheduled to perform
(vectorize and/or batch processing ).

If an asterisk (*) appears in these columns for a machine, then this type of
batch processing is scheduled for this machine.

If a machine is scheduled to do both types of batch processing, themachine
performs both types alternatively; it processes an entry from the Vectorize
queue, vectorizes the data, and then take an entry from the Render queue.

Environments

Displays the environments scheduled to be batch processed on a machine.

Themachine batch processes only the data from the environments listed in
this column.

pri Displays the priority level for batch processing on a machine. You can
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prioritize environments so that onemachine can perform the batch
processing before another.

If an asterisk (*) appears in the pri column, the environments are prioritized
for that machine. The priority order for the environments appears in
the Environments column (reads from left to right, highest to lowest
priority).

Time of Last Update

The Default schedule also indicates the last time the schedule was modified
for eachmachine.

This final column displays the date and time that the Default schedule was
last modified for eachmachine.

Modifying Default Schedules

When you are ready to modify the Default schedule, youmust specify the following information:

• Themachine(s) you want to update

• The type of batch processing work you want to assign

• The environments to process

After modifying the Default schedule, use the Showdef command to view your changes—seeDisplaying Default
Schedules on page 169.

How tomodify a Default schedule

1. In a Terminal, Command Prompt or Linux shell, type:

Setdef

2. Press Enter/Return.

You are prompted for themachine(s) whose Default schedule you want to modify.

INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all [all]:

3. Select themachines you want to view by typing the name of a singlemachine, a prefix (to select a range of
machines that start with the same prefix), or all to view all the Default schedules for all themachines.

If you press Enter/Return without specifying a machine, the command uses themachine name that appears
in brackets.

NOTE:
If you type a prefix, a list of machines that contain that prefix appears. Type the numbers that correspond to the
machines you want to view.

For example, if you have three machines that start with "hi", you can type hi as a prefix. The system would then
display a list of all the machines that start with"hi":

input a set of machines, or hit return to indicate all these machines:
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1 = hickey, 2 = highlander, 3=high-definition

You can either press Enter/Return to select all the machines in the list or you can select certain machines by typing
their corresponding numbers.

You are asked if you want to modify the Default schedule for moremachines.

DO YOU WANT TO INPUT MORE MACHINES (y/n) [n]:

4. Decide if you want to modify the Default schedule on other machines.

‣ Type y to select moremachines and press Enter/Return.

You are prompted to select other machines (see step 1 of this procedure).

‣ Type n to not select anymoremachines and press Enter/Return.

You are prompted to decide if you want vectorizing work performed on themachine.

INPUT TYPE OF WORK ALLOWED is vectorize work allowed (y/n) [yes]

5. Decide if you want themachines to perform vectorizing work on the selected machines.

‣ Type y to schedule vector batch processing and press Enter/Return.

‣ Type n to not schedule vector batch processing and press Enter/Return.

‣ If you press Enter/Return without entering y or n, the prompt uses the answer shown in brackets.

The system then prompts you to select if you want rendering work performed on themachine.

is render work allowed (y/n) [yes]

6. Select if you want themachines to perform rendering work on the selected machines.

‣ Type y to schedule Render batch processing and press Enter/Return.

‣ Type n to not schedule Render batch processing and press Enter/Return.

‣ If you press [Enter] without entering y or n, the prompt uses the answer shown in brackets.

You are prompted to select the environments to be scheduled for batch processing.

INPUT A SET OF DATABASE ENVIRONMENTS

1 = Production, 2 = Tutorials, 3 = Commercials default - [Production
Commercials]

All the environments in your system appear in this list, each one assigned to a number.

7. Type the number that corresponds to the environment(s) you want to schedule and press Enter/Return.
If you press Enter/Return without typing anything, the environments listed in brackets are used.

If you select more than one environment, the system asks if you want to establish a priority.

should processing of the DBenv's be prioritized? (y/n) [yes]

You can prioritize your environments so that batch processing works on the highest priority
environment first. If you do not define a priority, the batch processing does an equal amount of work for
each environment.

The order in which you type the environment numbers can determine their batch processing priority in
the schedule (the first environment you type has the highest priority). However, the order in which you

172



Harmony 12.1 Server Installation Guide

type the environments is not important if you do not want to prioritize the environments (by answering no
to the system prompt).

In this example, if you want to schedule only the Production and Tutorials environments for batch
processing, you would type: 1 2, indicating that Production has a higher priority than Tutorials for
batch processing.

8. Decide if you want to assign a priority to the environments you selected. If you press Enter/Return without
entering anything, the system uses the answer shown in brackets.

‣ Type y to prioritize batch processing.

‣ Type n to not prioritize batch processing.

The system prompts you to schedule the status of themachine(s).

input ON or OFF [on]:

9. Decide if you want to apply the Default schedule right away, making themachines available immediately.

‣ Type on to make themachines available for batch processing according to their defined Default
schedules and press Enter/Return.

‣ Type off to make themachines unavailable for batch processing, regardless of their defined Default
schedules, and press Enter/Return.

‣ If you press Enter/Return without entering on or off, the prompt uses the answer shown in brackets.

The Default schedule for the specified machines is set. The new schedule appears.

Using Periodic Schedules

The Periodic schedule is an optional schedule that defines a recurring period of timewhen a machine will perform
batch processing. You can create a Periodic schedule by specifying a day of the week (Monday, Tuesday, etc.) and
themachine will perform batch processing on the specified days for every week.

A Periodic schedule lists batch processing jobs for which youmust define a start and end date, and time. Each job
has its own set of batch processing parameters that are independent of the other jobs in the schedule.

For example, you can create a Periodic schedule for a machine so that it performs batch processing every night
from 20:00 that evening to 08:00 the following morning. Therefore, themachine would not perform batch
processing work during the day when the users would be present.

NOTE:
In terms of priority, the Periodic schedule is between the Default and Supervisory schedules. If there are no
Supervisory schedules for a machine, or the Supervisory schedule does not define the work to be done for a particular
period of time, the machine uses the Periodic schedule.

However, if you have an active Supervisory schedule , the machine follows this schedule before it follows either the
Periodic or Default schedules.

This section is divided as follows:

• Displaying Periodic Schedules on page 174

• Setting a Periodic Schedule on page 175

• Clearing a Periodic Schedule on page 178

• Using Default Schedules on page 168.
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• Using Supervisory Schedules on page 179.

Displaying Periodic Schedules

When you display a Periodic schedule, you can see all the batch processing machines that use this schedule and
when they are scheduled to perform the batch processing. The Periodic schedule also displays the type of
batch processing work (vectorize or render) and the environments that are scheduled for the processing work.

After you display the Periodic schedule, you canmodify it to change the time, type of batch processing, or
environments to process—see Setting a Periodic Schedule on page 175.

NOTE: You can display the Periodic schedule for only one machine at a time.

How to display a Periodic schedule

1. In a Linux shell, type:

Showper

You are prompted for themachine whose Periodic schedule you want to view.

INPUT MACHINE [hickey]:

2. Type the name of themachine for which you want to define a Periodic schedule.

If you press Enter/Return without specifying a machine, the command uses themachine name that
appears in brackets.

NOTE:
You can combine these two steps by adding the name of the machine you want to view at the end of the Showper
command.

For example, if the machine you want to view is called hickey, then you would type the following command in a
Linux shell to view its Periodic schedule.

Showper hickey

The Periodic schedule for that machine appears.
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Setting a Periodic Schedule

When you are ready to modify your Periodic schedule, you need to specify the following information:

• Themachine(s) for which you want to create or update the periodic schedule(s)

• The type of batch processing work you want to assign

• The environments to process

• When to start and stop the batch process

You can add jobs to the schedule if a Periodic schedule already exists for a particular machine, or you can clear
out any pre-existing jobs before setting new jobs in the schedule. You can clear a Periodic schedule without
setting any new jobs—seeClearing a Periodic Schedule on page 178.

How to define a Periodic schedule on a machine

NOTE:
If you press Enter/Return without entering anything, the command uses the information that appears in brackets of
commands.

1. In a Linux shell, type:

Showper

You are prompted for themachine(s) whose Periodic schedule you want to modify.

INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all [all]:

2. Select themachines you want to modify by typing the name of a singlemachine, a prefix (to select a range
of machines that start with the same prefix), or all to modify all the Periodic schedules for all the
machines.
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NOTE:
If you type a prefix, a list of machines that contain that prefix appears. Type the numbers that correspond to the
machines you want to view.

For example, if you have three machines that start with "hi", you can type hi as a prefix. The system would then
display a list of all the machines that start with"hi":

input a set of machines, or hit return to indicate all these machines:

1 = hickey, 2 = highlander, 3=high-definition

Press Enter/Return to select all the machines in the list or select specific machines by typing their corresponding
numbers.

You are asked if you want to modify the Periodic schedule onmoremachines.

DO YOU WANT TO INPUT MORE MACHINES (y/n) [n]:

3. Do one of the following:

‣ Type y to select moremachines.

‣ Type n to not select anymoremachines.

You are prompted to clear the existing schedule before defining new entries.

WOULD YOU LIKE TO CLEAR THE SCHEDULE OF PRE-EXISTING ENTRIES? (y/n) [n]:

4. Do one of the following:

‣ Type y to remove any existing schedules on themachine(s).

‣ Type n to preserve any existing schedules on themachine(s). The systemwill add your new entries to
the existing set of entries.

You are prompted to schedule any new entries in your Periodic schedule.

WOULD YOU LIKE TO SCHEDULE ANY ENTRIES? (y/n) [y]

5. Do one of the following:

‣ Type y to schedule new entries. Proceed to the next step to define the schedule.

‣ Type n to not schedule any new entries. This cancels the Setper command without scheduling any
new entries.

6. If you typed y to the previous prompt, you are prompted to activate or deactivate the selected
machines.

input ON or OFF [on]:

‣ Type on to activate the Periodic schedule for the selected machines.

‣ Type off to deactivate the Periodic schedule for the selected machines. Themachine(s) will not
perform any Periodic batch processing, regardless of what the other Periodic entries have been
scheduled.

You are prompted to decide if you want vectorizing work performed on themachine.

INPUT TYPE OF WORK ALLOWED is vectorize work allowed (y/n) [no]

7. Do one of the following:
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‣ Type y to schedule Vector batch processing.

‣ Type n to not schedule Vector batch processing.

The system prompts you to decide if you want rendering work performed on themachine.

is render work allowed (y/n) [yes]

8. Do one of the following:

‣ Type y to schedule Render batch processing.

‣ Type n to not schedule Render batch processing.

You are prompted to select the environments to be scheduled for batch processing. All the environments
in your system appear in this list, each one assigned to a number.

INPUT A SET OF DATABASE ENVIRONMENTS

1 = Production, 2 = Tutorials, 3 = Commercials default - [Production Commercials]

9. Type the number that corresponds to the environment(s) you want to schedule and press [Enter/Return]. If
you select more than one environment, the system asks if you want to establish a priority.

should processing of the DBenv's be prioritized? (y/n) [yes]

You can prioritize your environments so that batch processing works on the highest priority environment
first. If you do not define a priority, the batch processing does an equal amount of work for each
environment.

The order in which you type the environment numbers can determine their batch processing priority in the
schedule (the first environment you type has the highest priority). However, the order in which you type the
environments is not important if you don't want to prioritize the environments (by answering no to the
system prompt).

In this example, if you want to schedule only the Production and Tutorials environments for batch
processing, you would type: 1 2, indicating that Production has a higher priority than Tutorials for
batch processing.

10. Select if you want to assign a priority to the environments you selected.

‣ Type y to prioritize batch processing.

‣ Type n to not prioritize batch processing.

The scheduler prompts you to define the time and day when to start the Periodic batch processing.

INPUT BEGIN TIME in 24-hr. format [15:17] input day [wed]:

11. Type the time (in 24-hour format) and day (in day of the week format) when to begin batch processing and
press [Enter/Return].

The scheduler prompts you for the end time.

INPUT END TIME in 24-hr. format: input day [thu]:

12. Type the time (in 24-hour format) and the day (in day of the week format) when to stop the batch pro-
cessing and press Enter/Return.

A summary of the job you just scheduled appears. The scheduler then prompts you to confirm that you
want to enter this job in the schedule.
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13. Do one of the following:

‣ Type y to add this job into your Periodic schedule.

‣ Type n if you do not want to add this job into your Periodic schedule.

The scheduler gives you the opportunity to add another job to your Periodic schedule.

DO YOU WANT TO SCHEDULE ANOTHER EVENT (y/n) [y]

14. Do one of the following:

‣ Type y to add another job and press Enter/Return. Repeat steps 7 to 13.

‣ Type n if you do not want to enter another job and press Enter/Return.

When you finish adding jobs to the Periodic schedule, a summary of the entire Periodic schedule
appears.

Clearing a Periodic Schedule

If you decide that you do not need to have any recurring batch jobs, you can clear the scheduled jobs from the
Periodic schedule. Once the Periodic schedule is empty, the batch jobs in the Default schedule come into
effect.

You can clear existing jobs from a Periodic schedule without creating any new jobs. However, when you clear a
Periodic schedule, you clear all the jobs that exist for that schedule.

How to clear a Periodic schedule

1. Follow steps 1 to 3 in Setting a Periodic Schedule on page 175

2. Type y when you reach the following prompt:

WOULD YOU LIKE TO CLEAR THE SCHEDULE OF PRE-EXISTING ENTRIES? (y/n) [n]

3. Type n when you reach the following prompt:

WOULD YOU LIKE TO SCHEDULE ANY ENTRIES? (y/n) [y]

This clears the Periodic schedule and displays an empty schedule, confirming that the system cleared the
jobs.
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Using Supervisory Schedules

A Supervisory schedule forces a machine to perform batch processing for a non-recurring period of time. This
type of schedule, like the Periodic schedule, is optional. If you have a Supervisory schedule active for a period of
time, themachine performs batch processing according to that schedule before it references the Periodic or
Default schedules.

For example, you could force a machine to perform only Vectorize batch processing for the next four hours,
ignoring any other scheduled type of batch processing during that time.

A Supervisory schedule consists of a list of batch processing jobs for which youmust define a start and end date
and time. Each job has its own set of batch processing parameters that are independent of the other jobs in the
schedule.

NOTE: The Supervisory schedule holds the highest priority level, superseding the Periodic schedule and Default
schedule. Therefore, if you have an active Supervisory schedule, the machine follows this schedule before it follows
the Periodic or Default schedules.

This section is divided as follows:

• Displaying Supervisory Schedules on page 179

• Setting a Supervisory Schedule on page 180

• Clearing a Supervisory Schedule on page 183

• Using Default Schedules on page 168.

• Using Periodic Schedules on page 173.

Displaying Supervisory Schedules

When you display a Supervisory schedule, you can see all the batch processing machines that use this schedule
and when they are scheduled to perform the batch processing. The Supervisory schedule also displays the type of
batch processing work (vectorize or render) and the environments that are scheduled for the processing work.

After you display the Supervisory schedule, you canmodify it to change the time, type of batch processing, or
environments to process—see Setting a Supervisory Schedule on page 180.

NOTE: You can display the Supervisory schedule for only one machine at a time.

How to display a Supervisory schedule

1. In a Linux shell, type:

Showsup

You are prompted for themachine whose Supervisory schedule you want to view.
INPUT MACHINE [hickey]:
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2. Type the name of themachine for which you want to define a Supervisory schedule.

If you press Enter/Return without specifying a machine, the command uses themachine name that
appears in brackets.

NOTE:
You can combine these two steps by adding the name of the machine you want to view at the end of the Showsup
command.

For example, if the machine you want to view is called hickey, then you would type the following command in a
Linux shell to view its Supervisory schedule.

Showsup hickey

The Supervisory schedule for themachine appears.

Setting a Supervisory Schedule

When you are ready to modify your Supervisory Schedule, you need to specify the following:

• Themachine(s) for which you want to create or update the supervisory schedule(s)

• The type of batch processing work you want to assign

• The environments to process

• When to start and stop the batch process

You can add jobs to the schedule if a Supervisory Schedule already exists for a particular machine, or you can
clear out any pre-existing jobs before setting new jobs in the schedule. You can clear a Supervisory Schedule
without setting any new jobs (seeClearing a Supervisory Schedule on page 183).
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How to define a Supervisory schedule on a machine

NOTE:
If you press Enter/Return without entering anything, the command uses the information that appears in brackets of
commands.

1. In a Linux shell, type:

Showsup

You are prompted for themachine(s) whose Supervisory schedule you want to modify.

INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all [all]:

2. Select themachines you want to modify by typing the name of a singlemachine, a prefix (to select a range
of machines that start with the same prefix), or all to modify all the Supervisory schedules for all the
machines.

NOTE:
If you type a prefix, a list of machines that contain that prefix appears. Type the numbers that correspond to the
machines you want to view.

For example, if you have three machines that start with "hi", you can type hi as a prefix. The system would then
display a list of all the machines that start with"hi":

input a set of machines, or hit return to indicate all these machines:

1 = hickey, 2 = highlander, 3=high-definition

Press Enter/Return to select all the machines in the list or select specific machines by typing their corresponding
numbers.

You are asked if you want to modify the Supervisory schedule onmoremachines.

DO YOU WANT TO INPUT MORE MACHINES (y/n) [n]:

3. Do one of the following:

‣ Type y to select moremachines.

‣ Type n to not select anymoremachines.

You are prompted to clear the existing schedule before defining new entries.

WOULD YOU LIKE TO CLEAR THE SCHEDULE OF PRE-EXISTING ENTRIES? (y/n) [n]:

4. Do one of the following:

‣ Type y to remove any existing schedules on themachine(s).

‣ Type n to preserve any existing schedules on themachine(s). The systemwill add your new entries to
the existing set of entries.

You are prompted to schedule any new entries in your Supervisory schedule.
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WOULD YOU LIKE TO SCHEDULE ANY ENTRIES? (y/n) [y]

5. Do one of the following:

‣ Type y to schedule new entries. Proceed to the next step to define the schedule.

‣ Type n to not schedule any new entries. This cancels the Setper command without scheduling any
new entries.

6. If you typed y to the previous prompt, you are prompted to activate or deactivate the selected
machines.

input ON or OFF [on]:

‣ Type on to activate the Supervisory schedule for the selected machines.

‣ Type off to deactivate the Supervisory schedule for the selected machines. Themachine(s) will not
perform any Supervisory batch processing, regardless of what the other Supervisory entries have
been scheduled.

You are prompted to decide if you want vectorizing work performed on themachine.

INPUT TYPE OF WORK ALLOWED is vectorize work allowed (y/n) [no]

7. Do one of the following:

‣ Type y to schedule Vector batch processing.

‣ Type n to not schedule Vector batch processing.

The system prompts you to decide if you want rendering work performed on themachine.

is render work allowed (y/n) [yes]

8. Do one of the following:

‣ Type y to schedule Render batch processing.

‣ Type n to not schedule Render batch processing.

You are prompted to select the environments to be scheduled for batch processing. All the
environments in your system appear in this list, each one assigned to a number.

INPUT A SET OF DATABASE ENVIRONMENTS

1 = Production, 2 = Tutorials, 3 = Commercials default - [Production
Commercials]

9. Type the number that corresponds to the environment(s) you want to schedule and press [Enter-
/Return]. If you select more than one environment, the system asks if you want to establish a priority.

should processing of the DBenv's be prioritized? (y/n) [yes]

You can prioritize your environments so that batch processing works on the highest priority
environment first. If you do not define a priority, the batch processing does an equal amount of work for
each environment.

The order in which you type the environment numbers can determine their batch processing priority in
the schedule (the first environment you type has the highest priority). However, the order in which you
type the environments is not important if you don't want to prioritize the environments (by answering
no to the system prompt).
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In this example, if you want to schedule only the Production and Tutorials environments for batch
processing, you would type: 1 2, indicating that Production has a higher priority than Tutorials for
batch processing.

10. Select if you want to assign a priority to the environments you selected.

‣ Type y to prioritize batch processing.

‣ Type n to not prioritize batch processing.

The scheduler prompts you to define the time and day when to start the Supervisory batch processing.

INPUT BEGIN TIME in 24-hr. format [15:17] input day [wed]:

11. Type the time (in 24-hour format) and day (in day of the week format) when to begin batch processing and
press Enter/Return.

The scheduler prompts you for the end time.

INPUT END TIME in 24-hr. format: input day [thu]:

12. Type the time (in 24-hour format) and the day (in day of the week format) when to stop the batch pro-
cessing and press Enter/Return.

A summary of the job you just scheduled appears. The scheduler then prompts you to confirm that you
want to enter this job in the schedule.

13. Do one of the following:

‣ Type y to add this job into your Supervisory schedule.

‣ Type n if you do not want to add this job into your Supervisory schedule.

The scheduler gives you the opportunity to add another job to your Supervisory schedule.

DO YOU WANT TO SCHEDULE ANOTHER EVENT (y/n) [y]

14. Do one of the following:

‣ Type y to add another job and press Enter/Return. Repeat steps 7 to 13.

‣ Type n if you do not want to enter another job and press Enter/Return.

When you finish adding jobs to the Supervisory schedule, a summary of the entire Supervisory schedule
appears.

Clearing a Supervisory Schedule

If you decide you don't need to set a Supervisory schedule for your batch processing jobs, you can clear the
scheduled jobs from the Supervisory schedule. Once the Supervisory schedule is empty, the batch processing jobs
in the Periodic and Default schedules come into effect.

You can clear existing jobs from a Supervisory schedule without creating any new jobs. However, when you clear a
Supervisory schedule, you clear all of the jobs that exist for that schedule.
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How to clear a Supervisory schedule

1. Follow steps 1 to 3Setting a Supervisory Schedulein Setting a Supervisory Schedule on page 180.

2. Type y when you reach the following prompt:

WOULD YOU LIKE TO CLEAR THE SCHEDULE OF PRE-EXISTING ENTRIES? (y/n) [n]

The Supervisory schedule is cleared. An empty schedule displayed, confirming that the system cleared
the jobs.

Shutting Down and Starting Up Environments

In some cases, youmust shut down a machine so it does not process any batch jobs from an environment or for
a specific amount of time. Youmay want to, for example, shut down batch processing for all environments on a
singlemachine so you can reboot themachine. Or you can shut down one environment on all machines so you
canmove scenes in that environment to other machines.

To determine if an environment is shut down on a particular machine, type Status in a Command Shell or
Terminal. If you see an asterisk (*) in the SD column for a particular machine, this means at least one
environment is shut down on that machine.

You can view the Supervisory and Periodic schedules for the shut downmachines to isolate which environments
are shut down.

This section is divided as follows:

• Using Supervisory Schedules on page 179.

• Using Supervisory Schedules on page 179.

Shutting Down Environments

When you shut down an environment, this overrides whatever was scheduled for that environment (for all three
types of schedules). The environment remains shut down until you reinstate it by typing Suenv command in a
Command Shell or Terminal (see Starting Environments on page 186). You can shut downmultiple
environments onmultiplemachines, from anymachine in the network.

When shutting down an environment, the command prompts you for the environments you want to close and
themachines on which you want them to be shut down.
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How to shut down an environment on a machine

1. In a Command Shell or Terminal, type:

Sdenv

You are prompted for the environments to shut down:

INPUT DATABASES TO BE STOPPED

INPUT A SET OF DATABASE Environments

1 = Production, 2 = Tutorials, 3 = Commercials, default = [Production
Tutorials Commercials]

All the Environments appear in this list and each one has its own number.

2. Type the number that corresponds to each environment you want to shut down (separate each number by
a space) and press Enter/Return.

You are prompted you for themachine(s) on which you want the environments to be shut down:

INPUT MACHINE ON WHICH THESE DBENV'S ARE TO BE SHUTDOWN

INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all
[hickey]:

3. Select themachines that should not process the shut down environment by typing the name of a single
machine, a prefix (to select a range of machines that start with the same prefix), or all to shut down all
the environments on all themachines.

If you press Enter/Return without specifying a machine, the command uses themachine name that appears
in brackets.

NOTE:
If you type a prefix, a list of machines that contain that prefix appears. Type the numbers that correspond to the
machines you want to view.

For example, if you have three machines that start with "hi", you can type hi as a prefix. The system would then
display a list of all the machines that start with"hi":

input a set of machines, or hit return to indicate all these machines:

1 = hickey, 2 = highlander, 3=high-definition

Press Enter/Return to select all the machines in the list or select specific machines by typing their corresponding
numbers.

You are prompted to decide if you want to shut downmoremachines.
DO YOU WANT TO INPUT MORE MACHINES (y/n) [n]:

You are asked if you want to shut downmore environments and machines.

4. Do one of the following:

‣ Type y to select moremachines.
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‣ Type n to not select anymoremachines.

A summary of the shutdown appears:

here are the 3 machines you input: hickey weiner garneau

ALL MACHINES HAVE REPORTED. SHUT DOWN COMPLETE.

The Sdenv command waits for a response from all the selected machines. The Sdenv command does
not terminate a batch process that is currently running on a machine. If a machine is currently performing
a batch process, it will not shut down until it completes the queue entry.

Starting Environments

When you're ready to restart the batch process on an Environment that was shut down, use the Suenv
command. When you restart an Environment, you are prompted for the Environments you want to start up and
themachines you want them to start running on.

NOTE: If you accidentally restart an environment that is already active, nothing happens.

How to start an environment

1. In a Command Shell or Terminal, type:

Suenv

You are prompted for the environments to restart:

INPUT DATABASES TO BE STARTEDINPUT A SET OF DATABASE Environments

1 = Production, 2 = Tutorials, 3 = Commercials, default = []

All the environments in your system appear in this list and each one has a number.

2. Type the numbers that correspond to each environment you want to restart (separate each number by a
space) and press Enter/Return.

You are prompted for themachine(s) you want to process the environments:

INPUT MACHINE ON WHICH THESE DBENV'S ARE TO BE STARTED

INPUT A SINGLE MACHINE NAME, THE PREFIX OF A MACHINE NAME, OR all
[hickey]:

3. Select themachines for processing the environment by typing the name of a singlemachine, a prefix (to
select a range of machines that start with the same prefix), or all to restart all the environments on all
themachines.

If you press Enter/Return without specifying a machine, the command uses themachine name that
appears in brackets.
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NOTE:
If you type a prefix, a list of machines that contain that prefix appears. Type the numbers that correspond to the
machines you want to view.

For example, if you have three machines that start with "hi", you can type hi as a prefix. The system would then
display a list of all the machines that start with"hi":

input a set of machines, or hit return to indicate all these machines:

1 = hickey, 2 = highlander, 3=high-definition

Press Enter/Return to select all the machines in the list or select specific machines by typing their corresponding
numbers.

You are prompted to decide if you want to restart enviroments onmoremachines.
DO YOU WANT TO INPUT MORE MACHINES (y/n) [n]:

4. Do one of the following:

‣ Type y to select moremachines.

‣ Type n to not select anymoremachines.

A summary of the started machines appears:

here are the 3 machines you input: hickey weiner garneau

ALL MACHINES HAVE REPORTED. STARTUP COMPLETE.

A Summary of Scheduling Commands

The following table lists the batch processing scheduling commands and parameters that are useful for managing
the batch processing schedule.

Command Effect

Status

Displays the Schedule Status (default for all machines).

Options:

[machine]: Limits the display to specified machines
(separatemachine names with spaces).

[prefix]: Limits the display to machines with specified
prefix.

Showdef Displays Default schedules.

Setdef Modifies Default schedules.

Showper

Displays Periodic schedule (for a singlemachine only).

Options:

[machine]: Specifies themachine whose Periodic
schedule you want to display.

Setper Sets and/or clears Periodic schedule.
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Command Effect

Showsup

Displays Supervisory schedule (for a singlemachine only).

Options:

[machine]: Specifies themachine whose Supervisory
schedule you want to display.

Setsup Sets and/or clears Supervisory schedules.

Sdenv Shuts down environments.

Suenv Starts up environments.

start_process_starter
Starts process running on a machine (youmust be logged
into themachine, and should be SuperUser when running
this command).

tail -options file

Displays last 10 lines of specified file (Linux).

Options:

-n: Specifies the number of lines from the file to display.

-f: Updates the display as the file changes (must use Ctrl
+ C or Breal key to quit).

ps

Options:

-f: Displays full listing.

-u [username]: Limits display to specified Linux user
name.
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